# Table of Contents

## Preface

- Purpose ..........................................................................................................11
- Audience ........................................................................................................11
- Organization ................................................................................................12
- Using ABL documentation ............................................................................12
- References to ABL compiler and run-time features ....................................12
- References to ABL data types .....................................................................12
- Typographical conventions .........................................................................13
- Examples of syntax descriptions .................................................................14
- Long syntax descriptions split across lines ...............................................15
- Complex syntax descriptions with both required and optional elements ....16
- OpenEdge messages .....................................................................................16
- Obtaining more information about OpenEdge messages ..........................17

## Chapter 1: Introduction

- Alert definition ..............................................................................................19
- How OpenEdge Management alerts relate to rules and actions ..................20
- A cause and effect relationship ..................................................................20
- Using monitoring plans to set up rules-related criteria ..............................20
- Alert types ....................................................................................................21
  - Polled alerts ..............................................................................................21
  - Asynchronous alerts .................................................................................23
  - Internal alerts ............................................................................................24
  - For additional alert information ...............................................................24

## Chapter 2: Alerts Setup and Maintenance

- Reviewing initial monitoring plan settings ...............................................25
- Understanding alert options and default values ........................................26
- Configuring rules for individual resources ................................................28
  - Setting threshold values ..........................................................................28
  - Configuration Advisor ..............................................................................28
  - Setting properties for generated alerts .....................................................29
  - Defining actions for alerts .......................................................................31
- Viewing alert information ..........................................................................32
  - Viewing alerts ............................................................................................32
  - Viewing Alert details in the details frame ...............................................35
  - Views defined for collection pages .........................................................36
  - Viewing alerts in a resource’s home page ...............................................38
Chapter 3: Alerts Reference.................................................................57

Alert organization and properties..................................................62
  Alert properties...........................................................................62
  <Specific Log File Rule Name>....................................................63
ActionNotRun...............................................................................63
AS_AverageProcedureDurationHigh...........................................64
AS_BrokerAbnormalShutdown.....................................................64
AS_BrokerNormalShutdown.........................................................65
AS_BrokerStartup......................................................................65
AS_ClientAbnormalDisconnect....................................................65
AS_NameServerUnavailable.........................................................66
AS_QueueRequestPercentHigh....................................................66
AS_RejectedRequestPercentHigh................................................66
AS_ServerAdded.........................................................................67
AS_ServerKilled.........................................................................67
AS_ServerTrimmed.....................................................................68
AS_ServerUnavailable..................................................................68
BadSearchPattern......................................................................69
ContextSwitchHigh.....................................................................69
CPUBusyThresholdExceeded.......................................................69
CPUNotFound..............................................................................70
DB_AbnormalShutdown...............................................................70
<table>
<thead>
<tr>
<th>Alert Name</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB_AgentCrash</td>
<td>71</td>
</tr>
<tr>
<td>DB_AgentDown</td>
<td>71</td>
</tr>
<tr>
<td>DB_AgentIdle</td>
<td>71</td>
</tr>
<tr>
<td>DB_AgentReadError</td>
<td>72</td>
</tr>
<tr>
<td>DB_AgentStartup</td>
<td>72</td>
</tr>
<tr>
<td>DB_AIWritePercentLow</td>
<td>72</td>
</tr>
<tr>
<td>DB_AreaSpaceUtilizationHigh</td>
<td>73</td>
</tr>
<tr>
<td>DB_AutoStartFail</td>
<td>73</td>
</tr>
<tr>
<td>DB_BIPartialWritesHigh</td>
<td>74</td>
</tr>
<tr>
<td>DB_BIWritePercentLow</td>
<td>74</td>
</tr>
<tr>
<td>DB_BrokerReconnectFail</td>
<td>75</td>
</tr>
<tr>
<td>DB_BufferIOHigh</td>
<td>75</td>
</tr>
<tr>
<td>DB_BuffersFlushedatCheckpointHigh</td>
<td>76</td>
</tr>
<tr>
<td>DB_BusyAIBufferWaitsHigh</td>
<td>76</td>
</tr>
<tr>
<td>DB_BusyBIBufferWaitsHigh</td>
<td>77</td>
</tr>
<tr>
<td>DB_CheckpointLengthShort</td>
<td>77</td>
</tr>
<tr>
<td>DB_DatabaseCommitsLow</td>
<td>78</td>
</tr>
<tr>
<td>DB_DatabaseCrash</td>
<td>78</td>
</tr>
<tr>
<td>DB_DatabaseDown</td>
<td>78</td>
</tr>
<tr>
<td>DB_EmptyAIBuffersWaitsHigh</td>
<td>79</td>
</tr>
<tr>
<td>DB_EmptyBIBufferWaitsHigh</td>
<td>79</td>
</tr>
<tr>
<td>DB_FathomTrendDatabase</td>
<td>80</td>
</tr>
<tr>
<td>DB_NormalShutdown</td>
<td>80</td>
</tr>
<tr>
<td>DB_PartialAIBufferWritesHigh</td>
<td>80</td>
</tr>
<tr>
<td>DB_PhysicalReadHigh</td>
<td>81</td>
</tr>
<tr>
<td>DB_ReadsToRequestsHigh</td>
<td>81</td>
</tr>
<tr>
<td>DB_RecordWaitsHigh</td>
<td>82</td>
</tr>
<tr>
<td>DB_ResourceAdded</td>
<td>82</td>
</tr>
<tr>
<td>DB_ResourceDisabled</td>
<td>83</td>
</tr>
<tr>
<td>DB_ResourceEnabled</td>
<td>83</td>
</tr>
<tr>
<td>DB_ResourceNameConflict</td>
<td>83</td>
</tr>
<tr>
<td>DB_Startup</td>
<td>84</td>
</tr>
<tr>
<td>DB_TrendingStopped</td>
<td>84</td>
</tr>
<tr>
<td>DB_UserCountHigh</td>
<td>85</td>
</tr>
<tr>
<td>DB_VariableAreaExtentGrow</td>
<td>85</td>
</tr>
<tr>
<td>DiminishedFileGrowth</td>
<td>85</td>
</tr>
<tr>
<td>DiskAvgQueueHigh</td>
<td>86</td>
</tr>
<tr>
<td>DiskBusyThresholdExceeded</td>
<td>86</td>
</tr>
<tr>
<td>DiskNotFound</td>
<td>87</td>
</tr>
<tr>
<td>ExcessiveFileGrowth</td>
<td>87</td>
</tr>
<tr>
<td>FathomTrendingUnavailable</td>
<td>88</td>
</tr>
<tr>
<td>FileDoesNotExist</td>
<td>88</td>
</tr>
<tr>
<td>FileExists</td>
<td>89</td>
</tr>
<tr>
<td>FileIsDirectory</td>
<td>89</td>
</tr>
<tr>
<td>FileModified</td>
<td>89</td>
</tr>
</tbody>
</table>

OpenEdge Management: Alerts Guide and Reference
Contents

FileSizeEqual.................................................................90
FileSizeExceeded........................................................90
FileSizeLow.................................................................90
FileSizeNotEqual.......................................................90
FileStale.................................................................91
FileSystemNotFound..................................................91
FileSystemUsedThresholdExceeded.........................92
HTTPDownloadFailure..............................................92
HTTPRedirect..........................................................93
InvalidProgressVersion..............................................93
JobStartFailure.........................................................94
LatchWaitCountHigh.................................................94
LogActionWriteError................................................94
LogFileIOException.................................................95
LogFileNotFound.....................................................95
MalformedPattern...................................................96
MalformedURL.........................................................96
MemoryNotFound......................................................97
MS_BrokerAbnormalShutdown.................................97
MS_BrokerNormalShutdown.......................................97
MS_BrokerStartup....................................................98
MQA_BrokerAbnormalShutdown.................................98
MQA_BrokerNormalShutdown.....................................98
MQA_BrokerStartup..................................................99
NetworkResourceFailure..........................................99
NetworkResourceTardy..............................................99
NetworkResourceTimeout.........................................100
NetworkResourceUnreachable....................................100
NoContentInPage.....................................................100
NoSearchCriteria...................................................101
NS_AbnormalShutdown.............................................101
NS_ApplicationServiceNotFound.................................102
NS_BrokerRegistrationFailure...................................102
NS_BrokerTimeout....................................................102
NS_ClientRequestRejected.......................................102
NS_DuplicateBrokerUUID.........................................103
NS_NameServerReregisteredBroker.............................104
NS_NormalShutdown................................................104
NS_Startup.............................................................104
OD_BrokerAbnormalShutdown....................................105
OD_BrokerNormalShutdown........................................105
OD_BrokerStartup....................................................105
OR_BrokerAbnormalShutdown.....................................106
OR_BrokerNormalShutdown........................................106
OR_BrokerStartup....................................................106

OpenEdge Management: Alerts Guide and Reference
Preface

For details, see the following topics:

- Purpose
- Audience
- Organization
- Using ABL documentation
- Typographical conventions
- Examples of syntax descriptions
- OpenEdge messages

Purpose

This combination guide and reference provides information to assist you in understanding and working with the OpenEdge® Management alert feature.

Audience

This manual is designed for database administrators and end users of OpenEdge Management. This includes IT managers, ASP hosting companies, and others who are responsible for the day-to-day monitoring and management of resources.
Organization

Introduction on page 19
Introduces the alert feature, defines the alert types that can be generated, and identifies where you can find additional information about alerts in the OpenEdge Management documentation set.

Alerts Setup and Maintenance on page 25
Provides detailed information about setting up, maintaining, and displaying alerts.

Alerts Reference on page 57
Presents a comprehensive list of the OpenEdge-generated alerts and their associated polled or asynchronous property definitions.

Using ABL documentation

OpenEdge provides a special purpose programming language for building business applications. In the documentation, the formal name for this language is ABL (Advanced Business Language). With few exceptions, all keywords of the language appear in all UPPERCASE, using a font that is appropriate to the context. All other alphabetic language content appears in mixed case.

For the latest documentation updates see the OpenEdge Product Documentation Overview page on Progress Communities:


References to ABL compiler and run-time features

ABL is both a compiled and an interpreted language that executes in a run-time engine. The documentation refers to this run-time engine as the ABL Virtual Machine (AVM). When the documentation refers to ABL source code compilation, it specifies ABL or the compiler as the actor that manages compile-time features of the language. When the documentation refers to run-time behavior in an executing ABL program, it specifies the AVM as the actor that manages the specified run-time behavior in the program.

For example, these sentences refer to the ABL compiler's allowance for parameter passing and the AVM's possible response to that parameter passing at run time: "ABL allows you to pass a dynamic temp-table handle as a static temp-table parameter of a method. However, if at run time the passed dynamic temp-table schema does not match the schema of the static temp-table parameter, the AVM raises an error." The following sentence refers to run-time actions that the AVM can perform using a particular ABL feature: "The ABL socket object handle allows the AVM to connect with other ABL and non-ABL sessions using TCP/IP sockets."

References to ABL data types

ABL provides built-in data types, built-in class data types, and user-defined class data types. References to built-in data types follow these rules:

• Like most other keywords, references to specific built-in data types appear in all UPPERCASE, using a font that is appropriate to the context. No uppercase reference ever includes or implies any data type other than itself.
• Wherever integer appears, this is a reference to the INTEGER or INT64 data type.
• Wherever character appears, this is a reference to the CHARACTER, LONGCHAR, or CLOB data type.
• Wherever decimal appears, this is a reference to the DECIMAL data type.
• Wherever numeric appears, this is a reference to the INTEGER, INT64, or DECIMAL data type.

References to built-in class data types appear in mixed case with initial caps, for example, Progress.Lang.Object. References to user-defined class data types appear in mixed case, as specified for a given application example.

**Typographical conventions**

This documentation uses the following typographical and syntax conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Bold typeface indicates commands or characters the user types, provides emphasis, or the names of user interface elements.</td>
</tr>
<tr>
<td><em>Italic</em></td>
<td>Italic typeface indicates the title of a document, or signifies new terms.</td>
</tr>
<tr>
<td><strong>SMALL, BOLD CAPITAL LETTERS</strong></td>
<td>Small, bold capital letters indicate OpenEdge key functions and generic keyboard keys; for example, GET and CTRL.</td>
</tr>
<tr>
<td><strong>KEY1+KEY2</strong></td>
<td>A plus sign between key names indicates a <em>simultaneous</em> key sequence: you press and hold down the first key while pressing the second key. For example, CTRL+X.</td>
</tr>
<tr>
<td><strong>KEY1 KEY2</strong></td>
<td>A space between key names indicates a <em>sequential</em> key sequence: you press and release the first key, then press another key. For example, ESCAPE H.</td>
</tr>
</tbody>
</table>

**Syntax:**

<table>
<thead>
<tr>
<th>Fixed width</th>
<th>A fixed-width font is used in syntax, code examples, system output, and file names.</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Fixed-width italics</em></td>
<td>Fixed-width italics indicate variables in syntax.</td>
</tr>
<tr>
<td><em>Fixed-width bold</em></td>
<td>Fixed-width bold italic indicates variables in syntax with special emphasis.</td>
</tr>
<tr>
<td><strong>UPPERCASE fixed width</strong></td>
<td>ABL keywords in syntax and code examples are almost always shown in upper case. Although shown in uppercase, you can type ABL keywords in either uppercase or lowercase in a procedure or class.</td>
</tr>
<tr>
<td><strong>Period (.) or colon (:)</strong></td>
<td>All statements except DO, FOR, FUNCTION, PROCEDURE, and REPEAT end with a period. DO, FOR, FUNCTION, PROCEDURE, and REPEAT statements can end with either a period or a colon.</td>
</tr>
<tr>
<td><strong>[ ]</strong></td>
<td>Large brackets indicate the items within them are optional.</td>
</tr>
<tr>
<td>Convention</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>[]</td>
<td>Small brackets are part of ABL.</td>
</tr>
<tr>
<td>{}</td>
<td>Large braces indicate the items within them are required. They are used to simplify complex syntax diagrams.</td>
</tr>
<tr>
<td>{}</td>
<td>Small braces are part of ABL. For example, a called external procedure must use braces when referencing arguments passed by a calling procedure.</td>
</tr>
<tr>
<td></td>
<td>A vertical bar indicates a choice.</td>
</tr>
<tr>
<td>...</td>
<td>Ellipses indicate repetition: you can choose one or more of the preceding items.</td>
</tr>
</tbody>
</table>

**Examples of syntax descriptions**

In this example, `ACCUM` is a keyword, and `aggregate` and `expression` are variables:

**Syntax**

```
ACCUM aggregate expression
```

`FOR` is one of the statements that can end with either a period or a colon, as in this example:

```
FOR EACH Customer NO-LOCK:
    DISPLAY Customer.Name.
END.
```

In this example, `STREAM stream`, `UNLESS-HIDDEN`, and `NO-ERROR` are optional:

**Syntax**

```
DISPLAY [ STREAM stream ] [ UNLESS-HIDDEN ] [ NO-ERROR ]
```

In this example, the outer (small) brackets are part of the language, and the inner (large) brackets denote an optional item:

**Syntax**

```
INITIAL [ constant [ , constant ] ]
```
A called external procedure must use braces when referencing compile-time arguments passed by a calling procedure, as shown in this example:

**Syntax**

```
{ &argument-name }
```

In this example, EACH, FIRST, and LAST are optional, but you can choose only one of them:

**Syntax**

```
PRESELECT [ EACH | FIRST | LAST ] record-phrase
```

In this example, you must include two expressions, and optionally you can include more. Multiple expressions are separated by commas:

**Syntax**

```
MAXIMUM ( expression , expression [ , expression ] ... )
```

In this example, you must specify MESSAGE and at least one expression or SKIP [( n )], and any number of additional expression or SKIP [( n )] is allowed:

**Syntax**

```
MESSAGE { expression | SKIP [ ( n ) ] } ... 
```

In this example, you must specify {include-file, then optionally any number of argument or &argument-name = "argument-value", and then terminate with }:

**Syntax**

```
{ include-file
   [ argument | &argument-name = "argument-value" ] ... }
```

### Long syntax descriptions split across lines

Some syntax descriptions are too long to fit on one line. When syntax descriptions are split across multiple lines, groups of optional and groups of required items are kept together in the required order.

In this example, WITH is followed by six optional items:
Complex syntax descriptions with both required and optional elements

Some syntax descriptions are too complex to distinguish required and optional elements by bracketing only the optional elements. For such syntax, the descriptions include both braces (for required elements) and brackets (for optional elements).

In this example, ASSIGN requires either one or more field entries or one record. Options available with field or record are grouped with braces and brackets:

Syntax

```
ASSIGN { [ FRAME frame ] [ field [ = expression ] ]
[ WHEN expression ] } . . .
| { record [ EXCEPT field . . . ] }
```

OpenEdge messages

OpenEdge displays several types of messages to inform you of routine and unusual occurrences:

- **Execution messages** inform you of errors encountered while OpenEdge is running a procedure; for example, if OpenEdge cannot find a record with a specified index field value.

- **Compile messages** inform you of errors found while OpenEdge is reading and analyzing a procedure before running it; for example, if a procedure references a table name that is not defined in the database.

- **Startup messages** inform you of unusual conditions detected while OpenEdge is getting ready to execute; for example, if you entered an invalid startup parameter.

After displaying a message, OpenEdge proceeds in one of several ways:

- Continues execution, subject to the error-processing actions that you specify or that are assumed as part of the procedure. This is the most common action taken after execution messages.

- Returns to the Procedure Editor, so you can correct an error in a procedure. This is the usual action taken after compiler messages.

- Halts processing of a procedure and returns immediately to the Procedure Editor. This does not happen often.

- Terminates the current session.
OpenEdge messages end with a message number in parentheses. In this example, the message number is 200:

```
** Unknown table name table. (200)
```

If you encounter an error that terminates OpenEdge, note the message number before restarting.

**Obtaining more information about OpenEdge messages**

In Windows platforms, use OpenEdge online help to obtain more information about OpenEdge messages. Many OpenEdge tools include the following Help menu options to provide information about messages:

- Choose **Help > Recent Messages** to display detailed descriptions of the most recent OpenEdge message and all other messages returned in the current session.
- Choose **Help > Messages** and then type the message number to display a description of a specific OpenEdge message.
- In the Procedure Editor, press the **HELP** key or **F1**.

On UNIX platforms, use the OpenEdge pro command to start a single-user mode character OpenEdge client session and view a brief description of a message by providing its number.

**To use the pro command to obtain a message description by message number:**

1. Start the Procedure Editor:

   ```
   OpenEdge-install-dir/bin/pro
   ```

2. Press **F3** to access the menu bar, then choose **Help > Messages**.
3. Type the message number and press **ENTER**. Details about that message number appear.
4. Press **F4** to close the message, press **F3** to access the Procedure Editor menu, and choose **File > Exit**.
Introduction

This chapter introduces OpenEdge® Management alert features and identifies where you can find additional information about alerts in the documentation set.

For details, see the following topics:

• Alert definition
• How OpenEdge Management alerts relate to rules and actions
• Alert types

Alert definition

An alert is a notification that an event involving an OpenEdge Management resource has occurred. Alerts indicate that:

• A typical or routine event has occurred. For example, you can set up an alert to inform you that a database has started or stopped.
• A defined threshold has been met or exceeded. For example, you can set up an alert to be generated if the percentage of OpenEdge® AppServer client requests rejected during a polling interval exceeds the defined threshold. The alert identifies a performance issue you might want to address.
• A situation has occurred with an internal operation. In this situation, an alert automatically fires. You cannot set up internal alerts.
When you configure resource monitoring, you define rules to ensure that a resource performs according to criteria you set. These rules cause OpenEdge Management to generate alerts if a specific condition occurs. Use alerts to ensure that:

- You are automatically notified if a rule is broken; all alert details appear and are accessible through the management console.
- OpenEdge Management triggers optional, predefined corrective actions. You can customize and select actions, such as sending an e-mail to an employee, sending a voice message to a PDA (Personal Data Assistant), or initiating a job action or log file action in response to an event.

The prompt display of an alert and its associated details in the management console and the automatic and timely initiation of actions allow you to quickly recognize and correct resource-related violations.

**How OpenEdge Management alerts relate to rules and actions**

Alerts are triggered in response to rules that you associate with a resource or job. Each rule has its own unique alert and action definition. The content of this book focuses on alerts associated with resources. For details about setting up alerts for jobs and job instances, see the relevant section of *OpenEdge Management: Resource Monitoring*.

**A cause and effect relationship**

You can set up a simple, automated chain of events to ensure that you are notified of any resource rule violations. This sequence executes as follows:

1. Some condition causes a rule for an active resource to be violated.
2. The rule violation causes an alert to be triggered.
3. The alert causes a specific predefined action to occur.

**Note:** You define the action to be triggered by the alert. An alert can be triggered many times if a given condition exists, but the action that is associated with the alert will be run only when the alert is initially triggered. Once the alert is cleared, the alert and its related action can fire again.

**Using monitoring plans to set up rules-related criteria**

The values defined for each set of rule, alert, and action elements comprise an OpenEdge Management monitoring plan. A resource monitoring plan uses:

- A rule definition and its associated threshold values
- An action that is initiated when the rule is violated
- A schedule to identify when the rule is applied
- A polling interval that determines how often the rule is evaluated

Once a polling interval (that is, the time frequency with which a resource is monitored) is set, OpenEdge Management recognizes the values you define for the monitoring plan attributes and executes them.
Alert types

There are three types of alerts:

• Polled
• Asynchronous
• Internal

A rule's definition determines what type of alert is associated with the rule.

Polled alerts

A polled alert is generated when the scheduled evaluation of a monitored resource detects an error or other condition in the resource. Polled alerts generally require threshold values to be defined so that a resource's performance can be tracked in response to these parameters. For example, threshold values can include defining criteria such as a performance level that is lower or higher than a given number, or identifying the age of a file being older than a particular time (that is, minutes, hours, days, and so forth). Threshold values give you the flexibility to refine rule conditions based on the particular performance values you choose for a resource.

Factors associated with assessing threshold values

OpenEdge Management can trigger an alert when a monitored resource performs outside the currently defined value for a threshold rule. However, the defined polling interval could be set such that \( x \) number of polling cycles (as defined in the Throw alert after polled field in the Rule definition section of a monitoring plan) must be complete before the alert is triggered.

For example, a CPU resource can be polled hourly to see if the CPU usage exceeds 90%. If the percentage does exceed 90%, an alert is generated. However, the alert will not trigger until the number of polling cycles as defined in the Throw alert after polled field is also exceeded.

Alerts that gather data through this polling process allow you to assess data polled over time to determine if your thresholds are too high or too low. You can adjust these threshold values, and the frequency with which the polling cycles are set to occur, at any time to refine your data collection.

The interpretation of a threshold value can vary from resource type to resource type. Differences in these interpretations can also affect what an alert display means for these various resource types. For an explanation of these resource-specific calculations, see the appropriate resource-specific rule details in the system, network, or file resource rule calculations in OpenEdge Management: Resource Monitoring. For details about database rule details, see OpenEdge Management: Database Management. For details about OpenEdge Management rules related to the OpenEdge server products, see OpenEdge Management: Servers, DataServers, Messengers, and Adapters.
Example: Reviewing polled alert fields

The following figure shows the Create Monitoring Plan page for a disk resource in OpenEdge Management. The Rule definition section contains the Alert if disk activity exceeds field, which is an example of a rule for which a polled alert is generated. The value defined for this threshold, along with the values defined for the associated action and alert fields in this same section, enable the triggering of a polled alert.

Figure 1: Sample polled alert-related data

The Monitoring plan definition section contains the Polling Interval field. Based on the value you define for this field, the resource is checked (polled) according to the time interval specified. The default value of 900 seconds as shown in Figure 1: Sample polled alert-related data on page 22 establishes that this disk resource must be checked every 15 minutes and a count kept of the number of passed or failed polls. This count is used to assess the alert properties values defined in the Rule definition to determine when to throw or clear an alert. Note that the Alerts Enabled field is selected in Figure 1: Sample polled alert-related data on page 22. Alerts fire when the resource is active and a rule is violated.

The Rule definition section shows the fields related to rules, alerts, and actions for a disk resource monitor. Note that the rule definition is actually a combination of the threshold value and the specific values related to actions and alerts that identify the activities performed if this threshold is exceeded.

As shown in the Rules definition section in Figure 1: Sample polled alert-related data on page 22, polled alerts require you to either accept default values or set values in a combination of fields to establish the following criteria:

- The specific rule's threshold which, when violated, causes an alert to trigger. In Figure 1: Sample polled alert-related data on page 22, the rule threshold is set at 90.0% in the Alert if disk activity exceeds field.
- The severity of the alert as defined in the Alert severity field: Informational, Warning, Error, or Severe. In Figure 1: Sample polled alert-related data on page 22, the severity chosen is Error.
- The number of polls in which the condition must occur before an alert is generated. In Figure 1: Sample polled alert-related data on page 22, the Throw alert after field indicates that the alert will be generated after one failed poll.
• When to throw additional alerts: after a clear, or after a certain number of failures.

• The action, if one is specified, to perform in OpenEdge Management when the alert is generated.

• The number of polls in which the condition must occur without the detection of any rule violations before the alert is automatically cleared. In Figure 1: Sample polled alert-related data on page 22, the value of 0 in the Clear alert after field indicates that the alert will not be automatically cleared. (If you choose not to clear an alert automatically, you must clear it manually.) See Clearing alerts through the management console on page 41 for more details about manually clearing alerts.

• The action, if one is specified, to perform in OpenEdge Management when the alert is cleared.

For more detailed information about defining alerts, see Configuring rules for individual resources on page 28.

Asynchronous alerts

An asynchronous alert is generated by a resource the moment a specific condition is detected, regardless of the polling interval set for that resource. Many asynchronous alerts identify violations related to mission-critical and time-sensitive activities. Others, such as AS_BrokerNormalShutdown or DB_AgentStartup, function as confirmations of normal, or expected, operational status.

Some common mission-critical conditions for which you can define an asynchronous alert include:

• Database abnormal shutdown

• OpenEdge Management Trend Database Unavailable

• AppServer added

Other events for which you can define asynchronous alerts are more time-dependent. For example, if a running job has not completed in a specified period of time, you can be notified by an asynchronous alert. This situation could indicate that there is either a runaway or a hung job. In these types of instances, the firing of an asynchronous alert would inform you immediately of the situation so that you could take appropriate action.

Example: Reviewing asynchronous alert fields

The following figure shows a sample rule definition section of a resource monitoring plan. This sample shows both the alert severity and the action currently associated with a database agent abnormal shutdown condition.

Figure 2: Sample asynchronous alert-related data

All asynchronous rules also have an Always throw new alert field. If you retain the default check mark for this option, a new asynchronous alert of this type fires each time this rule is violated. Given the sample data shown in the figure, a unique alert will fire each time a database agent shuts down in an abnormal manner.
You can review each of these alert instances on the **Alert Detail Summary** page. If you clear the value in the **Always throw new alert** field, the alert fires once, so that an alert message does not display in the user interface each time the alert is triggered. However, even if you suppress this alert display, the **Occurrence count** field value increases on the **Alert Detail Summary** page on a subsequent occurrence.

**Internal alerts**

OpenEdge Management internal alerts automatically inform you of events that occur internally to OpenEdge Management and for which you cannot set up specific alert definitions. For example, there is no option to define a rule, associated alert, and action for an internal event such as a CPU resource being unable to trend data to the OpenEdge Management Trend Database. In this instance, OpenEdge Management automatically triggers an alert.

Although OpenEdge Management automatically generates alerts for internal events, the alerts associated with internal situations appear on the management console and are processed in a manner similar to polled and asynchronous alerts. For more information about reviewing and processing alert data, see **Alerts Setup and Maintenance** on page 25 and the internal alert details in **OpenEdge Management internal alerts** on page 55.

**For additional alert information**

The following table identifies where you can find additional information about alerts and alert-related topics.

<table>
<thead>
<tr>
<th>For details about . . .</th>
<th>See . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting up, maintaining, and displaying alerts</td>
<td><strong>Alerts Setup and Maintenance</strong> on page 25 in this guide</td>
</tr>
<tr>
<td>Each generated alert and its associated polled or asynchronous property definition</td>
<td><strong>Alerts Reference</strong> on page 57 in this guide</td>
</tr>
<tr>
<td>All the basic elements of resource monitoring</td>
<td><strong>OpenEdge Management: Resource Monitoring</strong></td>
</tr>
<tr>
<td>Trending alert data to the OpenEdge Management Trend Database according to a database's schema definition</td>
<td><strong>OpenEdge Management: Trend Database Guide and Reference</strong></td>
</tr>
<tr>
<td>Creating and running OpenEdge Management-based reports that contain alert data</td>
<td><strong>OpenEdge Management: Reporting</strong></td>
</tr>
</tbody>
</table>
Alerts Setup and Maintenance

A key benefit of OpenEdge Management is the ability to generate alerts for certain conditions that occur on actively monitored resources. Within OpenEdge Management, you can then establish actions that occur in response to the triggering of an alert.

For details, see the following topics:

- Reviewing initial monitoring plan settings
- Configuring rules for individual resources
- Viewing alert information
- Clearing alerts through the management console
- Disabling alerts
- Accessing alert information from the command line
- OpenEdge Management internal alerts

Reviewing initial monitoring plan settings

OpenEdge Management provides default options and values for various monitoring plan settings at the global, resource type, and individual resource monitor levels. You can change or override these options and values at any time. This section briefly reviews these initial monitoring plan settings, focusing specifically on the alert-specific options and default capabilities.
The following figure illustrates the alert default hierarchy and related options. See Understanding alert options and default values on page 26 for details about these options.

**Figure 3: Alerts default and override hierarchy**

**OpenEdge Resource Monitoring Configuration Page and OpenEdge General Configuration Page**
These pages are accessible from Option → Configuration, and they support
- Turning polling on or off for all resources
- Turning alerts on or off for all resources
- Setting a default action to be run in response to all internal alerts

**Resource Monitor Defaults Pages**
The Resource Monitor Defaults page for each resource type—database, file, network, OpenEdge, and system—has default values that include
- Default polling attributes appropriate to each resource type

**Resource Monitoring Plan Pages**
The Rule Definition section for monitoring plans supports
- Overriding or accepting default values that can be associated with an individual rule, alert, and polling interval

**Understanding alert options and default values**

*Figure 3: Alerts default and override hierarchy* on page 26 highlights some of the default values and the override hierarchy available when you set up resource monitoring plans. The primary purpose of the diagram is to focus on the alert-related options available at the global, resource type, and individual resource monitor levels.
**General and Resource Monitoring options**

The top block in Figure 3: Alerts default and override hierarchy on page 26 identifies the options and defaults you can set globally on the *OpenEdge Management General Configuration* page and the *OpenEdge Management Resource Monitoring Configuration* page. You access these pages by choosing Options in the OpenEdge Management console.

Establishing alert-related options at this level can help to promote consistency within your alert data through the use of default values. However, you can override these default global settings at the resource type or individual resource monitor levels.

After you have defined your initial configuration settings, you can refine particular global settings by:

- Changing the alert-related selections.
- Turning global settings on or off. For example, you can elect to suspend OpenEdge Management's alerts generation feature, or enable or disable resource polling for all active resource monitors.

**Resource Monitor Defaults pages**

The middle block in Figure 3: Alerts default and override hierarchy on page 26 focuses on alert-related options available on the *Resource Monitor Defaults* pages. Among the various defaults values that you can set from each resource-specific default page, you can display and change default polling attributes associated with each resource type.

A polling interval determines how often a rule is evaluated. Therefore, you can determine a uniform polling interval that OpenEdge Management uses as a part of the criteria for determining when a rule violation will cause an alert to be triggered. Resource type default values can also be overridden at the individual resource monitor level.

**Resource Monitoring Plan pages**

The bottom block in Figure 3: Alerts default and override hierarchy on page 26 identifies the lowest level in this hierarchy. This individual resource monitor level inherits values set at the higher global or resource type levels. When you override values on a *Resource Monitoring Plan* page for an individual resource monitor, your changes affect only the specific resource monitor.

**For additional reference information**

The following table identifies where you can find additional details about monitoring plans and alerts.

<table>
<thead>
<tr>
<th>For details about . . .</th>
<th>See . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting an action to be applied to all internal alerts</td>
<td><em>OpenEdge Management internal alerts on page 55</em></td>
</tr>
<tr>
<td>Accessing and changing values associated with resource monitor types</td>
<td>The appropriate sections in <em>OpenEdge Management: Resource Monitoring</em></td>
</tr>
<tr>
<td>Accepting or overriding values at the individual resource level</td>
<td><em>Configuring rules for individual resources on page 28</em></td>
</tr>
</tbody>
</table>
Configuring rules for individual resources

This section describes the steps involved in configuring a rule in OpenEdge Management, including:

- Setting threshold values
- Setting properties, including a severity level, for generated alerts
- Defining actions for alerts

As described in Reviewing initial monitoring plan settings on page 25, default polling attributes automatically appear at the individual resource level. You can change or override them to address your needs. The following sections explain what each of these activities involves.

Setting threshold values

Threshold values identify the rule component criteria of the polling attributes associated with a resource. These values typically identify the highest or lowest acceptable resource performance-related value for a specific resource. The type of threshold value varies according to the resource type. The OpenEdge Management System resource type threshold values are often characterized by the highest or lowest value definitions. The OpenEdge Management Network resource type threshold values relate to values defined for response times being greater than a specified value, or no response within a defined period of time.

During the monitoring process, when OpenEdge Management finds a value that is outside the defined threshold value, the rule is considered violated. This rule violation causes the alert to be generated and the action to trigger. See How OpenEdge Management alerts relate to rules and actions on page 20 for more information.

Knowing how threshold values are interpreted can help you to interpret more accurately the context of a specific alert. For an explanation of these resource-specific calculations, see the appropriate resource-specific rule details in the system, network, or file resource rule calculations in OpenEdge Management: Resource Monitoring. For information about database rule details, see OpenEdge Management: Database Management. For details about OpenEdge server-related rules, see OpenEdge Management: Servers, DataServers, Messengers, and Adapters.

You can use threshold values supplied through these means:

- Default values
- Values you type directly into the threshold fields in the Rule definition section
- Values determined by the Configuration Advisor (AppServer, database, WebSpeed® Transaction Server, CPU, disk, and FileSystem in OpenEdge Management only)

Configuration Advisor

The OpenEdge Management Configuration Advisor collects data about typical operating activities for specific resource rules for a time period that you set. Based on an analysis of this data, the Configuration Advisor suggests a range of threshold values from which you can select and then apply to a rule.

The Configuration Advisor works with these specific resource types: AppServer, database, WebSpeed Transaction Server, CPU, disk, and FileSystem.
See *OpenEdge Management: Database Management* for details about how the Configuration Advisor determines database resource-related recommended rule threshold settings. See *OpenEdge Management: Servers, DataServers, Messengers, and Adapters* for details about how the Configuration Advisor calculates WebSpeed Transaction Server broker- and AppServer broker-related recommended rule threshold settings. See *OpenEdge Management: Resource Monitoring* for details about how the Configuration Advisor can be used to suggest rule thresholds for CPU, disk, and file system resources based on data in the OpenEdge Management Trend Database.

Setting properties for generated alerts

The alert-related properties are:

- Alert severity
- Throw alert after
- Clear alert after

The **Alert severity** property is set for all polled and asynchronous alerts. The **Throw alert after** property and the **Clear alert after** property provide a mechanism to reduce unnecessary noise in your polled alerts.

Assigning an alert’s severity

You can assign one of four severity levels to an alert. This allows you to choose which alerts are assigned highest priority based on the specific needs of your organization. The four levels of severity, in increasing severity, are:

- Information
- Warning
- Error
- Severe

To assign a severity to an alert, choose the desired severity from the **Alert severity** drop-down menu located in the **Rule definition** section of a monitoring plan page.

Specifying when to throw an alert

*Noise* is the normal variability that can occur while a resource is being monitored. For example, a CPU might run at 75% utilization with infrequent spikes of 100% utilization. The infrequent spikes are noise. You probably do not need to be alerted to those spikes because they do not reflect the true overall performance of the CPU. To avoid unnecessary alerts like these, you can set the **Throw alert after** and **Clear alert after** properties appropriately.

For example, you determine how many times a condition must occur before an alert is generated. Setting a low number, such as 1, means you are more susceptible to noise. Setting this value to a higher number, such as 3, reduces the likelihood of noise alerts, but also means an event must occur three times in a row before an alert is generated. The higher the setting of the **Throw alert after** property, the longer it takes to generate an alert. For example, with a **Throw alert after** property set to 3, three sample periods occur before the alert is generated.
Editing alert properties

Alert properties are located on the Rule Definition section of a resource's Rule: <Rule name> page. Review and update the values associated with these alert properties as you edit a rule for a resource.

The following procedure reviews the steps to edit a rule, noting the location and use of the alert properties with the help of an example of an AppServer instance.

To edit a rule for an AppServer instance:

1. In the OpenEdge Management console menu, choose one:
   - Select Library > View > Rule Sets.
   - Select Library > Go to Library > View Rule Sets.

   The Library.Rule Sets page appears

2. Type AppServer or its instance name in the Name field and select it.


   **Note:** While searching for an instance of a resource, if you do not find the required instance, click Filter icon next to Name field to change the filtering option and repeat step 2.

3. Click a rule set assigned to the resource monitor. If you have not added any rule set, click Default_AS_RuleSet.


4. Click a rule listed in the Rules selected for this Rule Set section. For example, Abnormal Shutdown.

   The Rule: <AppServer Abnormal Shut Down> page appears.

5. Click Edit. In the Rule Definition section, you can edit alert properties.

   The following table guides you in reviewing and updating values associated with the alert properties:

<table>
<thead>
<tr>
<th>To change this alert property . . .</th>
<th>Perform this action . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Type the recommended threshold value. See Setting threshold values on page 28 for more information.</td>
</tr>
<tr>
<td>Alert Severity</td>
<td>Select the drop-down list option to display the four severity options: Information, Warning, Error, and Severe.</td>
</tr>
<tr>
<td>Throw alert after</td>
<td>Type the number of failed polls after which an alert should fire. (For most resources, the default value is 1. However, the default value for network resource monitors is 2.) To minimize noise, consider setting this property to a low number for critical resources and to a higher number for less critical resources.</td>
</tr>
</tbody>
</table>

   **Note:** This property is not applicable to all resource monitors and does not appear on every resource property page.
### Defining actions for alerts

You can associate actions with each alert. Possible actions include:

- **Default Action** — Define a default action. You can modify the default action, or you can create a new action by copying and editing the existing default action.

- **Email Action** — Within the email action are options to do the following:
  - **Default Clear** — Clear the action.
  - **Default Mail** — Send an e-mail notification. This action can be used to send e-mail to one or more operators.

---

<table>
<thead>
<tr>
<th>To change this alert property . . .</th>
<th>Perform this action . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Throw additional alerts</strong></td>
<td>Choose when OpenEdge Management will throw additional alerts. Possible values are after a clear or specific number of failures.</td>
</tr>
<tr>
<td><strong>On alert perform action</strong></td>
<td>Select the drop-down list option to display the five actions: Default_Action, Default_Clear_Action, Default_Mail_Action, Default_Pager_Action, and Default_Task_Action. Select an action that OpenEdge Management will take when an alert is generated. The default is Default_Action.</td>
</tr>
</tbody>
</table>
| **Clear alert after**               | Enter one of the following possible values to indicate when you want an alert to be cleared once the condition that prompted the alert has been resolved:  
  - 0 — The alert is not cleared automatically. You must manually clear all alerts.  
  - 1 — The alert is automatically cleared the first time the resource successfully passes a poll.  
  You can alternatively type a value greater than 1 to indicate that the alert will not be cleared until the resources passes this specified number of consecutive polls. This can prevent anti-noise from clearing an alert prematurely. |
| **On clear perform action**         | Select a user-defined action or a compound action. For example, OpenEdge Management might run a job that was defined as an action. The default is None. |
| **Always throw new alert**          | Mark the check box to fire an alert each time the alert is triggered. Clear the check box to fire the alert once, so that an alert message does not display in the user interface each time the alert is triggered. |

6. Click **Save**.

Any changes made to the alert properties appear on the updated Rule: <AppServer Abnormal Shut Down> page.

---

OpenEdge Management: Alerts Guide and Reference
• **Default Pager** — Send a message to electronic devices that support a text message display, such as a computer, a PDA, a pager, or a cell phone.

• **Default Task Action** — The running of a defined job. You can use this action to perform a recovery procedure that remedies the alert condition.

For example, you can configure an e-mail action to send a message to the operator responsible for the resource on which an error occurred. You can also configure an alert to send e-mail to the responsible operator and execute a particular command at the same time. For detailed steps on creating actions and associating alerts with them, see the appropriate sections in *OpenEdge Management: Resource Monitoring*.

### Viewing alert information

Details related to all outstanding alerts regardless of their type—polled, asynchronous, or internal—are visible through the OpenEdge Management console. You can review alert data through various access points, such as:

- Reviewing information of unseen, total, worst severity, and most recent alerts by selecting **Alerts** in the OpenEdge Management console menu.
- Selecting **Alerts > Go to Alerts** in the console menu to display the alerts in the grid frame.
- Reviewing summary alert information that can be displayed on views defined for collections pages.
- Reviewing alerts associated with a specific resource in the **Alerts** column of the **Resources** view.
- Reviewing alerts specific to a resource in the resource's home page.
- Reviewing alerts associated with a particular resource on the resource's monitoring summary page.
- Reviewing alert details that can be sent by e-mails to electronic mail boxes, PDAs, or other types of electronic devices that support text message displays
- Generating and reviewing alert data using the OpenEdge Management reporting feature
- Reviewing alert-related data in the AdminServer log file
- Reviewing data stored in the OpenEdge Management Trend Database

### Viewing alerts

You can view alerts of a specific resource in the **Alerts** page or **Resources** page. Note that regardless of which of these two options you use, alerts appear in association with a specific resource as identified by the resource naming convention, `AdminServer name:resource name`
Viewing alerts in the Alerts page

The following figure shows a sample of the contents you might see in the OpenEdge Management Alerts page when you click Alerts > Go to Alerts in the management console menu.

Figure 4: Outstanding alerts displayed on the Alerts page

You can find and perform the following on the Alerts page:

- Icons related to an alert's severity level appear to the left of a brief alert message.
- A grid frame that supports tooltips. A tooltip displays summary about an alert.
  When you place your cursor over an alert icon, summarized alert message details appear after a few moments.
- Sort alerts by Message, Resource Name, Last occurrence, First occurrence, or Alert Name
- Group alerts by AdminServer, Resource, or Severity Using the drop-down menu in the Group By field.
- Filtering options to select and display Alerts for resource, Alerts for adminserver, Alerts of type, or Alerts that last occurred prior to.

Each alert's complete contents can be displayed on the Alert details Summary page by clicking the name of the alert in the grid frame. See Viewing Alert details in the details frame on page 35 for more information.
Viewing alerts in the Resources page

The following figure shows the Resources page with Alerts column, when you click Resources > Go to Resources in the management console menu.

Figure 5: Alerts displayed in the Resources page

You can find the following information in the Resources page:

- Icons related to an alert’s severity level appear in the Alerts column along with the number of Open and Unseen alerts of a resource.

- A figure that shows the Alerts section of the Resource view when you click a resource. This section displays the types of open alerts for the selected resource.

- Tooltip information that contains the reason for generation of an alert.

If you stop and restart OpenEdge Management, the outstanding alerts list clears. This same alert information cannot be reloaded. However, if the conditions that originally triggered the alerts still exist when OpenEdge Management restarts, new alerts are generated.

**Note:** Resource changes can happen very quickly, and the information contained in the Alerts list and the Alerts Detail Summary page represents the operational status of your system at the moment the information was collected. Click Refresh as you view alert details to ensure that you are reviewing the most current information.

For detailed information about each alert, see Alerts Reference on page 57.
Viewing Alert details in the details frame

Information about each outstanding, individual, open alert appears in the details frame in the Alert details Summary page, as shown in the following figure.

Figure 6: Alert details Summary page

To view the details of an alert in the Alert details Summary page:

Click the name of the alert in any of the following pages:

- The Alerts page.
- Alerts section of the Resources page.
- A resource’s home page.
- The Resource Monitoring Summary page of a resource.

The Alert details Summary page comprises:

- Navigational and task buttons
- Alert details for the individual alert
- General alert data for all outstanding alerts

For information about clearing an individual alert, see Clearing individual alerts on page 41.

Navigating the Alert details Summary page

The following table describes the buttons on the Alert details Summary page that allow you to navigate the alerts.

Table 3: Alert details Summary page buttons

<table>
<thead>
<tr>
<th>Click . . .</th>
<th>To . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous</td>
<td>Display the previous alert on the Alert details Summary page.</td>
</tr>
<tr>
<td>Next</td>
<td>Display the next alert on the Alert details Summary page.</td>
</tr>
</tbody>
</table>
To . . . Click . . .

<table>
<thead>
<tr>
<th>Clear</th>
<th>Clear the current alert.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark Seen/Unseen</td>
<td>Mark the current alert as seen or unseen.</td>
</tr>
<tr>
<td></td>
<td>Quick reference information about Unseen alerts displays as a total number next to the Alerts category on the menu bar. Seen and Unseen alert status also appears for individual alerts in the Resource list frame view when you use tooltips.</td>
</tr>
<tr>
<td></td>
<td>See Viewing alerts on page 32 and Viewing alerts in the Resources page on page 34 for more information.</td>
</tr>
</tbody>
</table>

**Alert details**

Alert details include the following information:

- **AdminServer** — The name of the resource AdminServer. You can click this link to display the AdminServer's detail page.
- **Resource** — The resource's name. You can click this link to display the resource's detail page.
- **Severity** — The severity level of the alert: Severe, Error, Warning, or Information.
- **Seen by** — Who has viewed the alert.
- **First occurrence** and **Last occurrence** — When the alert was first and last noticed.
- **Occurrence count** — The total number of times the alert has been generated. An alert can be triggered many times if a given condition exists, but the action that is associated with the alert will be run only when the alert is initially triggered. The value in the Occurrence count field increases for this initial triggering and each subsequent triggering of an alert.
- **Reason** — The reason the alert occurred.

If you intend to clear an alert, you can optionally enter some relevant text about the alert in the space provided. See Clearing alerts through the management console on page 41 for more information.

**General Alert Statistics and Legend**

The Alert Statistics, Resource Statistics, and Legend sections provide data relevant to all outstanding alerts. The following list briefly describes each of these sections:

- **Alert Statistics** — Displays a running tally of the number of open and unseen alerts. The Last field displays the date and time that the last alert occurred.
- **Resource Statistics** — Displays a running tally of the number of monitored resources across all AdminServers, the total number of alerts currently registered, and the percentage of the alerts per total number of resources.
- **Legend** — Displays static reference details that identify the specific icon with its associated severity level. Depending on the page you are viewing, either the icon or its associated text is used to identify severity.

**Views defined for collection pages**

You can display outstanding alert details in views defined for a collections page in OpenEdge Management.
Resources with alerts viewlet

Collections allow you to define the contents of the Resources with alerts standard viewlet in the Dashboard page. The viewlet displays a list of resources in a collection that currently has one or more outstanding alerts. The following figure shows an example of the OpenEdge Management Resources with alerts viewlet.

For each resource defined as a collection member in a specific collection view, this viewlet displays an alert icon to indicate the alert's severity. (If multiple alerts exist for a single resource, the worst severity is shown.)

The Customize Viewlet icon appears in the upper-right corner of the viewlet. Click the icon to modify the criteria associated with this viewlet. For details about how to change this criteria, see Customizing alert details on page 38.

Collection members viewlet

The following figure shows an OpenEdge Management Collection members viewlet that is also a standard viewlet whose contents you can define.

Figure 7: Collection members viewlet sample

For each resource defined as a collection member in a specific collection view, the viewlet can display an alert icon to indicate an alert exists and to identify the alert's severity. (If multiple alerts exist for a single resource, the worst severity is shown.) To display more specific details about a resource, select the individual resource link and view the resource's monitoring plan.

Alert severity legend viewlet

You can display the Alert severity legend on any OpenEdge Management collection view. This legend identifies the severity level identified by each alert icon.

The following figure shows a sample customized view of an OpenEdge Management My Collections page that includes standard viewlets for Resources with alerts, and Alert severity.

Figure 8: A customized view of the My Collections page

For more information about defining the content and layout of customized views, see the appropriate sections in OpenEdge Management: Resource Monitoring.
Customizing alert details

Collections support different options that allow you to tailor the alert details that appear on an OpenEdge Management collections page. From the options available on the Customize Viewlet page, you can modify what appears in the Resource with alerts viewlet that appears on a main collections page.

To customize alert and resource details on an OpenEdge Management collections page:

1. Click the Customize Viewlet icon that appears in the upper-right corner of the Resources with alerts standard viewlet. The Customize Viewlet page appears:

2. Select one of the following options in the Resources with alerts to show section:
   
   - **All resources in project** — Includes all resources in OpenEdge Management whether a resource is in a collection or not
   - **All resources in collection** — Limits resource inclusion to those resources defined for a specific collection
   - **All resources in collection and its descendants** — Identifies resources in a collection and resources defined in sub-collections associated with the collection

3. Select a maximum of three options in the Fields to display section.
   
   By default, all three options are selected. To deselect any option, click the checkmark.

4. Click Save.

   Any changes you make to Resources with alerts to show and Fields to display settings appear in the Resources with alerts viewlet the next time you view the collections page.

Viewing alerts in a resource’s home page

The home page of any resource in OpenEdge Management displays 5 of the most recent alerts associated with that resource. Click the name of the alert to see the details of the alert in the Alert details Summary page.

When there are more than 5 recent alerts, the page displays a See complete list button. Click this button to see all the alerts associated with the OpenEdge Management resources in the Alerts page. Use filtering options to find the alerts associated with a specific resource.
Viewing alerts details in the Resource Monitoring Summary page

The following figure shows an example of how alerts associated with an individual resource appear on the Resource Monitoring Summary page.

**Figure 9: Alerts associated with a specific active resource monitor**

![Alerts example](image)

To view additional details about alerts noted in the Alerts section:

Do one of the following:

- Place your cursor over the alert icon. Momentarily, summarized alert information appears. This information is available through the Tooltips option.
- Click the individual alert link. Complete alert data appears on the Alert details page.

Sending e-mail notifications

If you elect to define an action for an alert, you can choose to send e-mail notifications to one or more recipients you set up during the initial OpenEdge Management configuration. The content of the e-mail message is similar to the data that appears on the Alert details Summary page.

OpenEdge Management supplies these default e-mail actions, each of which you can customize:

- `Default_Clear_Action`
- `Default_Mail_Action`
- `Default_Pager_Action`
- `Default_Task_Action`

To access the OpenEdge Management default e-mail actions:

1. In the console menu, choose one:
   - Select **Library > View > Actions**.
Chapter 2: Alerts Setup and Maintenance

- Select Library > Go to Library > View Actions.

The Library.Actions page appears.

2. Click E-mail Action from the actions listed in the detail frame.

The OpenEdge Management default e-mail actions appear in Library.Actions.E-mail Action page.

The e-mail that the recipient receives in an electronic mail box, PDA, or other electronic device also contains links to OpenEdge Management, a link to the resource involved, and a link to alert details as they display on the Alert details Summary page. From the Alert details Summary page, you can review and process the information, as needed.

See OpenEdge Management: Resource Monitoring for details about initiating e-mail notifications and changing the content and format of e-mail messages.

OpenEdge Management reports

From Reports in the OpenEdge Management console menu, you can create and display report information related to alerts and alert information trended to the OpenEdge Management Trend Database. The Realtime Reports section and View Report Templates option in the Reports home page provide access to various report detail and summary reports you can generate.

For example, the Open Alert Detail and Open Alert Summary report options in the Realtime Reports section help you examine all outstanding alerts at a glance. By selecting the View Report Templates option, you can use predefined templates such as alertGeneral and alertIndividual to analyze alerts.

For information about accessing and running these reports, see OpenEdge Management: Reporting.

Displaying the OpenEdge Management log file

All alert types are logged in the OpenEdge Management log file. (Since OpenEdge Management runs as a managed process within the AdminServer, the OpenEdge Management log file is the AdminServer log file.) An entry is added to the log file whenever an alert is either generated or cleared.

Note: Alerts are logged in the OpenEdge Management log file only if they are generated. If polling or alerting options are turned off, alerts are not generated.

To access the OpenEdge Management log file:

1. Click Reports > Go to Reports in the management console menu.

   The OpenEdge Management Reports categories appear in the Reports home page.

2. Select AdminServer Log File in the Diagnostic Reports section to display the AdminServer log file.

The OpenEdge Management Trend Database

Like data from several other sources in OpenEdge Management, all alert data that is generated is stored in the OpenEdge Management Trend Database. However, alerts are trended only if the following conditions exist:

- The polling and alerting options are turned on so that OpenEdge Management can generate alerts.
- The trending option is turned on so that OpenEdge Management can trend the alert-generated data.
Clearing alerts through the management console

You can manually clear alerts through the management console or the command-line interface. This section describes how to clear alerts manually through the management console. For details about clearing alerts using the command-line interface, see Accessing alert information from the command line on page 44.

You can also set the Clear alert after property of an alert so that the alert is automatically cleared when the condition that caused the alert no longer exists. See Configuring rules for individual resources on page 28 for more information.

Clearing individual alerts

OpenEdge Management supports clearing individual alerts.

To clear an alert from the Alert details Summary page:

1. In the Alerts page, click the name of the alert you want to clear.
   The alert's details appear on the Alert details Summary page.
2. Enter a comment, if you want, about the alert you are clearing.
3. Click Clear.
   OpenEdge Management clears the alert and removes from the Alerts page.

You can also clear individual alerts from the following pages:

- The Alerts page.
- A resource's home page.
- The Resource Monitoring Summary page of a resource

When clearing an individual alert from these two pages, a Clear Alert confirmation box appears. Enter a comment, if you want, about the alert you are clearing and click Clear to confirm. See OpenEdge Management internal alerts on page 55 for details about defining an action for alerts.

**Note:** Mark Seen allows you to track who viewed each alert. The Seen by field lists the name of the user who first views the alert. When chosen, the Mark Seen button label becomes Mark Unseen, which allows you to change the seen status of the alert.
Clearing alerts in bulk

OpenEdge Management enables you to clear alerts in bulk from the Alerts page, as shown in the following figure.

Figure 10: Alerts page

To clear alerts in bulk:

1. Click the Filter option on the Alerts page.
2. Select from the following options to display the alerts you want to clear:

<table>
<thead>
<tr>
<th>Option. . .</th>
<th>Select . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert for resource</td>
<td>A resource name from the associated drop-down list (the default selection)</td>
</tr>
<tr>
<td>Alerts for adminserver</td>
<td>An AdminServer name from the associated drop-down list</td>
</tr>
<tr>
<td>Alerts of type</td>
<td>An alert type available in the associated drop-down list</td>
</tr>
<tr>
<td>Alerts that last occurred prior to</td>
<td>A date in the dd/mm/yyyy format at a specific time</td>
</tr>
</tbody>
</table>

3. Select the check box on the top-left of the Alerts page to select all the displayed alerts. Deselect any alerts that you do not want to clear at this time.

4. Click Clear.

   The Clear Alert confirmation box appears. Enter a comment, if you want, about the alert you are clearing and click Clear to confirm. See OpenEdge Management internal alerts on page 55 for details about defining an action for alerts.

   The unseen alert count as noted in the Alerts menu in the management console menu displays a total of zero unseen alerts at this time.

   Optionally, you can also:
   - Select multiple or all alerts in the Alerts page and click Clear to remove the alerts.
   - Use the Clear all alerts option to remove the alerts displayed in a resource’s home page, and the Resource Monitoring Summary page.
Disabling alerts

Sometimes you might want to disable alerts, such as when you know your database is going to be unavailable due to a dump and load or another procedure.

There are three ways to disable alerts to prevent OpenEdge Management from generating them:

• Disable alerts in a monitoring plan. This method allows polling of your resources to continue.
• Disable an individual resource. This method does not allow your resource to be polled.
• Disable all alerts (that is, polled, asynchronous, and internal alerts) on the OpenEdge Management Resource Monitoring Configuration page.

Disabling alerts in a monitoring plan

The steps you perform to disable alerts in a monitoring plan apply to all resource types being monitored.

To disable all alerts in a monitoring plan for a resource:

1. Click Resources > Go to Resources in the OpenEdge Management console menu.
   All resources managed by your console appear in the grid frame.
2. Filter or search for, and select the resource whose alerts you want to disable.
3. Click Monitoring Plans in the Command and Control section to access monitoring plans for OpenEdge resources.
   Monitoring Plans appear directly on the resource details page for all System resources.
4. Click Edit associated with the Default_Schedule_Plan field.
   The Edit Default_Schedule Monitoring Plan page for the selected resource appears.
5. Clear the Alerts Enabled check box to disable alerts.
   Alerts will not be generated, but monitoring activities continue and the resource’s status continues to be updated.
6. Click Save.

Disabling an individual resource monitor

Disabling an individual resource monitor prevents any monitoring activities from occurring for that resource. When a resource is disabled using this procedure, all resource polling, alert generation, and information trending cease. Resource monitors that are currently disabled are easily identified in the management console. A gray Resource Status icon precedes the resource’s name when the resource appears in the list frame.

The method used to disable resources depends on whether the resource is a system, network, or file resource, or a database or an OpenEdge server resource.

• To disable a system, network, or file resource monitor:
  a) Click Resources > Go to Resources in the OpenEdge Management console menu.
     All resources managed by your console appear in the grid frame.
  b) Filter or search for, and select the resource whose alerts you want to disable.
c) Click **Edit** at the top of the resource details page. The **Properties** section appears.

d) Clear the **Enabled** check box.

e) Click **Save**.

When you refresh the resources grid frame, the color of the status icon for the disabled resource in the **Status** column changes to gray.

**To disable other OpenEdge resource monitors:**

a) Click **Resources** on the management console menu bar.

b) From the list of resources, click the Edit icon to go to the details page for the resource whose monitoring you want to disable.

c) Click **Control** or **Broker Control** (depending on the resource) in the **Command and Control section**. The **Resource Control** page appears.

d) Click **Edit**. Clear the **Enabled** check box to disable the database resource.

e) Click **Save**. When you refresh the list frame, the color of the status icon for the disabled resource in the **Status** column changes to gray.

**Disabling alerts for all resources**

You can disable the appearance of all types of alerts—polled, asynchronous, and internal—from the OpenEdge Management console.

To disable alerts:

1. Select **Options > Resource Monitoring** in the OpenEdge Management console.

   The **OpenEdge Management Resource Monitoring Configuration** page appears.

2. Clear the **Generate alerts** check box.

3. Click **Submit**.

**Accessing alert information from the command line**

You can use the OpenEdge Proenv utility to perform the following actions from the command line:

- **Start, query, and stop OpenEdge Management.**

- **Clear an alert.**

- **Use other alert commands** (firealert and alertlist).

- **Access command-line help.**

You can also use the command line to manage the OpenEdge Management configuration database. For details on the commands you can enter, see the appropriate section of *OpenEdge Management and OpenEdge Explorer: Getting Started*. 
Using the Proenv utility

You can use the OpenEdge Proenv utility to perform certain OpenEdge Management actions from the command line.

You access the Proenv utility by choosing Start > Programs (or All Programs) > Progress > OpenEdge > Proenv. The environment window sets the shell environment variables needed for executing both OpenEdge Management and OpenEdge commands, as shown in the following figure.

**Figure 11: Proenv window**

![](image)

Starting, querying, and stopping OpenEdge Management

Use the following syntax to start, query, or stop OpenEdge Management from the command line:

**Syntax**

```
fathom [-start | -query | -stop] [options]
```

The following table describes the options you can use when starting or stopping OpenEdge Management.
Table 5: Options for starting and stopping OpenEdge Management

<table>
<thead>
<tr>
<th>Option syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-host &lt;host&gt;</td>
<td>Host where the AdminServer process resides.</td>
</tr>
<tr>
<td>-port &lt;port&gt;</td>
<td>Port where the AdminServer runs. Default is 20931.</td>
</tr>
<tr>
<td>-timeout &lt;time&gt;</td>
<td>Time, in seconds, for OpenEdge Management to wait for a response. Default is 240 seconds.</td>
</tr>
<tr>
<td>-user &lt;user-name&gt;</td>
<td>Username on machine where the AdminServer resides. Default is current user.</td>
</tr>
<tr>
<td>-password &lt;user-password&gt;</td>
<td>Password associated with the specified username. Not needed for a local connection.</td>
</tr>
<tr>
<td>-ssl</td>
<td>Connect to OpenEdge Management only if Secure Sockets Layer (SSL) is enabled on the WebServer.</td>
</tr>
</tbody>
</table>

**Note:** Use of the -password parameter might allow others to see your password in readable, clear text.

**Example**

You want to connect to your AdminServer but you do not want to wait more than five minutes for the connection to be made. Enter the following syntax to start OpenEdge Management from the command line:

**Syntax**

```
fathom -start -timeout 300
```

Enter the following syntax to stop OpenEdge Management from the command line and specify that the command-line interface tool wait five minutes before reporting an error:

**Syntax**

```
fathom -stop -timeout 300
```

To learn the execution status of OpenEdge Management with an AdminServer port number of 1905, enter the following syntax:
Syntax

```bash
fathom -query -port 1905
```

Clearing an alert

To clear an alert from the command line, use the following syntax:

Syntax

```bash
fathom [-httpport <port-number>] -clear [option] [-comment '<comment text>']
```

**Note:** You specify `-httpport` only if OpenEdge Management is running on a port other than the default of 9090.

The following table lists options to use with the `fathom -clear` command.

**Table 6: Clear alert command options**

<table>
<thead>
<tr>
<th>Option syntax</th>
<th>Purpose</th>
<th>How to use</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-httpport &lt;port-number&gt;</code></td>
<td>Identifies the port number if it is not the default port of 9090</td>
<td>Provide the <code>-httpport</code> option followed by the port number.</td>
</tr>
<tr>
<td><code>-comment '&lt;comment-text&gt;'</code></td>
<td>Provides a comment when clearing an alert</td>
<td>Provide the <code>-comment</code> option followed by the comment text. The text must be enclosed in single quotation marks.</td>
</tr>
<tr>
<td><code>-alert &lt;alert-name&gt;</code></td>
<td>Clears all instances of a particular alert for one specific resource, or for all resources within a specific AdminServer</td>
<td>Provide the <code>-alert</code> command followed by the alert name. Then provide either the resource name or the resource type.</td>
</tr>
<tr>
<td><code>[-AdminServer &lt;AdminServer&gt;]</code></td>
<td></td>
<td>Options are defined as follows:</td>
</tr>
<tr>
<td><code>[-resource &lt;resource&gt;]</code></td>
<td></td>
<td>•  <code>-AdminServer</code> — The name of a AdminServer as defined in OpenEdge Management.</td>
</tr>
<tr>
<td><code>[-restype &lt;resource type&gt;]</code></td>
<td></td>
<td>•  <code>-alert</code> — The name of the alert as defined in OpenEdge Management.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>•  <code>-resource</code> — The name or the reference key of the resource as defined in OpenEdge Management. See <strong>Using the alertlist command with additional options</strong> on page 51 for details about the reference key.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>•  <code>-restype</code> — The resource type. The type of resource is limited to one</td>
</tr>
</tbody>
</table>

Accessing alert information from the command line
How to use

Purpose

How to use

<table>
<thead>
<tr>
<th>Option syntax</th>
<th>Purpose</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>-alertid &lt;alert id number&gt;</td>
<td>Clears an alert by its number (regardless of the resource or its type)</td>
<td>Provide the -alertid option followed by its number.</td>
</tr>
<tr>
<td>-all[-restype &lt;resource type&gt;]</td>
<td>Clears:</td>
<td>Provide the -all command without an option to clear all alerts, or with one of these options to clear particular alerts:</td>
</tr>
<tr>
<td>[-resource &lt;resource&gt;]</td>
<td>• All alerts</td>
<td>• -restype — The resource type. The type of resource is limited to one of the following: database, file, network, openedge, or system.</td>
</tr>
<tr>
<td>[-alert &lt;alert name&gt;]</td>
<td>• All alerts for a particular resource type</td>
<td>• -resource — The name or the reference key of the resource as defined in OpenEdge Management. See Using the alertlist command with additional options on page 51 for details about the reference key.</td>
</tr>
<tr>
<td>[-AdminServer &lt;AdminServer&gt;]</td>
<td>• All alerts for a particular resource</td>
<td>• -alert — The name of the alert as defined in OpenEdge Management.</td>
</tr>
<tr>
<td>[-severity &lt;severity&gt;]</td>
<td>• All instances of a particular alert for all resources</td>
<td>• -AdminServer — The name of a AdminServer as defined in OpenEdge Management.</td>
</tr>
<tr>
<td></td>
<td>• All alerts for a specific AdminServer</td>
<td>• -severity — The alert severity: Severe, Error, Warning, or Informational.</td>
</tr>
<tr>
<td></td>
<td>• All alerts for a specific severity</td>
<td></td>
</tr>
</tbody>
</table>

Example

OpenEdge Management polls your Sports2000 database and sends an alert for Record Waits High (the alert sent when waits for records are above a defined threshold). To clear this alert from the command line, enter the following:

```
fathom -httpport 8080 -clear -alert RecordWaitsHigh -comment 'Cleared by Admin'
```

Note: You specify -httpport only if OpenEdge Management is running on a port other than the default of 9090.
Using the -firealert command

Use the following syntax to fire an alert:

```bash
fathom -firealert [alertmessage]
```

OpenEdge Management also supports generation of application-specific alerts. In your application, you can send alerts to OpenEdge Management using the -firealert options shown in the following figure.

**Figure 12: -firealert command options**

![Image of -firealert command options]

**Example**

You want to fire an alert regarding the CPU. Enter the following on the command line:

```bash
fathom -firealert JOBFAILED -resource CPU -msg 'JOB XYZ FAILED'
```

The alert fires, as shown below:

**Figure 13: Firing an alert**

![Image of firing an alert]

You can then look at the alert details for the CPU. Enter the following on the command line:

```bash
fathom -alertlist -detail -resource CPU
```
The alert details appear, as shown below:

**Figure 14: -firealert command example**

Using the -alertlist command with group selection options

You can display an alert list by specifying one of the -alertlist command group selection options on the command line. The following table identifies and describes each group selection option.

**Table 7: Alert list command group selection options**

<table>
<thead>
<tr>
<th>Option syntax</th>
<th>Purpose</th>
<th>How to use</th>
</tr>
</thead>
<tbody>
<tr>
<td>-alert</td>
<td>To view a list of all instances of a particular alert</td>
<td>Provide the name of the alert you want to see.</td>
</tr>
<tr>
<td>-resource</td>
<td>To view a list of alerts for a particular resource</td>
<td>Provide the name of the resource whose alerts you want to see listed.</td>
</tr>
<tr>
<td>-AdminServer</td>
<td>To view alerts associated with a specific AdminServer</td>
<td>Provide the name of the AdminServer whose alerts you want to see listed.</td>
</tr>
<tr>
<td>-retype</td>
<td>To view a list of alerts for a particular resource type</td>
<td>Provide the resource type whose alerts you want to see listed. The resource type is limited to one of the following: database, file, network, system, or openedge.</td>
</tr>
<tr>
<td>-severity</td>
<td>To view a list of alerts of a particular severity</td>
<td>Provide the severity level of alerts you want to see listed: severe, error, warning, or informational.</td>
</tr>
</tbody>
</table>

Use the following syntax to display an alert list:

**Syntax**

```
fathom -httpport 8080 -alertlist [group selection option] [keyword value]
```

**Note:** You specify `-httpport` only if OpenEdge Management is running on a port other than the default of 9090.
You can also use two additional options, the -detail and -verbose options, presented in Table 8: Alert list command options to display additional details on page 51 with the group selection options highlighted in Table 7: Alert list command group selection options on page 50.

Although the command line does not limit the number of options you can type into the command line, only the last group selection option identified on the command line is processed.

The following figure identifies a command line that generates a group selection based on the -restype option where the resource type is identified as system. Note that the resource name, listed in the Resource column, specifies the AdminServer name and associated resource name. Although this level of detail provides more information about a resource, it does not completely eliminate the possibility of confusion among resources with similar or identical names.

Figure 15: -restype group selection option results

Using the alertlist command with additional options

The following table describes the additional options -detail and -verbose.

Note: Unlike the group selection options highlighted in Table 7: Alert list command group selection options on page 50, the -detail and -verbose options will be processed regardless of the position in which you enter them on the command line.

Table 8: Alert list command options to display additional details

<table>
<thead>
<tr>
<th>Option syntax</th>
<th>Purpose</th>
<th>How to use</th>
</tr>
</thead>
<tbody>
<tr>
<td>-detail</td>
<td>To format the display to provide a block of information about the alert, shown in the command line. The block of information matches what you see when you display the alert in the console. See Table 9: Alert list details on page 52 for a summary of the alert list details.</td>
<td>Provide the -detail option along with the option whose alert information you want to see listed.</td>
</tr>
<tr>
<td>-verbose</td>
<td>To change the resource column of the displayed alerts from the generic format AdminServer:resource name to the fully qualified resource key. See Figure 16: -restype group option with verbose option results on page 52 to see an example of how to use the -verbose option.</td>
<td>Provide the -verbose option along with the option whose alert information you want to see listed.</td>
</tr>
</tbody>
</table>
Figure 16: -restype group option with verbose option results on page 52 identifies a command line that generates a group selection based on the -restype option that also includes the -verbose option. Note that the resource name, listed in the Resource column, specifies the *fully qualified resource key*. A fully qualified resource key is the most complete reference to a resource. The default format for a fully qualified resource key identifies each resource by its AdminServer name, the resource category to which the resource belongs, and the specific resource type and associated resource name.

In Figure 16: -restype group option with verbose option results on page 52, the fully qualified resource key information identifies *localhost* as the AdminServer, the resource category as *system*, and the specific cpu resource name as *CPU*.

**Note:** The AdminServer name *localhost* is logically the same as the AdminServer name for the system where OpenEdge Management is installed and running.

Use the fully qualified resource key to:

- Ensure that you are not confusing one resource name with another one that is either identical or similar. For example, it is possible to confuse a wsbroker1 on one AdminServer with another wsbroker1 on a different AdminServer. Referencing a resource by its explicit fully qualified resource key eliminates confusion as to what resource you are working with.

- Provide easy access to the complete resource information. You can cut and paste the fully qualified resource key into the command line when you use the -resource group option.

**Note:** Due to the use of the colon in the fully qualified resource key between the AdminServer name and the resource category information, this format might need to be put in quotation marks on UNIX systems.

The following table lists the details that can appear in the alert list.

**Table 9: Alert list details**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert ID</td>
<td>The number given to the alert.</td>
</tr>
<tr>
<td>Alert name</td>
<td>The name of the alert.</td>
</tr>
<tr>
<td>Alert severity</td>
<td>Whether the alert is considered an error, a warning, or informational or severe in nature.</td>
</tr>
<tr>
<td>Alert message</td>
<td>The content of the alert message; for example, notification that the Database Resource known as the OpenEdge Management Trend Database has been enabled.</td>
</tr>
<tr>
<td>Alert count</td>
<td>The number of times the alert has occurred.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AdminServer</td>
<td>The name of the AdminServer to which the resource belongs.</td>
</tr>
<tr>
<td>Resource</td>
<td>The name of the resource; for example, OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Last fire date</td>
<td>The time and date when the alert was last fired.</td>
</tr>
<tr>
<td>First fire date</td>
<td>The time and date when the alert was first fired.</td>
</tr>
<tr>
<td>Has been seen?</td>
<td>Whether the alert has been seen yet (either true if it has been seen or false if it has not been seen).</td>
</tr>
<tr>
<td>Seen by</td>
<td>If the alert has been seen, the name of the user who saw it. (If the alert has not been seen, the Seen by field does not appear.)</td>
</tr>
</tbody>
</table>

**Examples**

Enter the following command to see a list of existing OpenEdge Management alerts from the command line:

```
fathom -alertlist
```

Information about the current alerts appears, as shown below.

**Figure 17: -alertlist in the command line**

In Figure 17: -alertlist in the command line on page 53 there are eight alerts across a number of resources. As identified in the Resource column, all of these resources are on the localhost AdminServer. The alert ID numbers (ID) and severity (Severity) are also provided.

Enter the following command for a list of alerts for all OpenEdge server resources:

```
fathom -alertlist -restype openedge
```
You see any alerts that exist for any OpenEdge server resources (openedge) listed. If there are no existing alerts, you receive the message shown below.

**Figure 18: -alertlist for openedge resource type**

![Alert List](image1.png)

To see specific details about the alerts that exist for system resources, use either the -detail option or the -verbose option.

Enter the following command to examine the results of using the -detail option:

```
fathom -alertlist -restype system -detail
```

The details appear, as shown below.

**Figure 19: -alertlist command used with -detail option**

![Alert Details](image2.png)

Enter the following command to examine the results of using the -verbose option:

```
fathom -alertlist -restype system -verbose
```

The details appear, as shown below.

**Figure 20: -alertlist command used with -verbose option**

![Verbose Alerts](image3.png)
OpenEdge Management internal alerts

OpenEdge Management internal alerts automatically inform you of events that occur internal to OpenEdge Management and for which you cannot set up specific alert definitions. For example, there is no option to define a rule, associated alert, and action for an internal event such as the fact that the CPU resource could not trend data to the OpenEdge Management Trend Database. In this instance, OpenEdge Management automatically triggers an alert to inform you of this internal activity.

Defining actions for all internal alerts

OpenEdge Management provides specific options for the internal alert feature. You can select the actions for OpenEdge Management to associate with all internal alerts that are triggered.

To access the actions to perform on internal OpenEdge Management alerts:

1. Select Options > General in the OpenEdge Management console.
   The OpenEdge Management General Configuration page appears.

2. You can choose to select the following:
   • Start OpenEdge Management automatically
   • Prompt for comments on alert clear
   • Require comments on alert clear
   • Sign up for Customer Experience improvement program

3. From the drop-down list box associated with the Action to perform on internal OpenEdge Management alerts field, select the action that you want OpenEdge Management to perform in response to internally generated alerts.
   For specific details about default actions, see the section about actions in OpenEdge Management: Resource Monitoring.

Note: The Generate alerts option on the OpenEdge Management Resource Monitoring Configuration page governs all alerts—polled, asynchronous, or internal—that appear in the management console. To enable this option for internal alerts, you must select the Generate alerts option and the Action to perform on internal OpenEdge Management alerts on the OpenEdge Management General Configuration page.
This chapter provides detailed information about the asynchronous alerts and polled alerts that OpenEdge Management can generate for asynchronous rules and polled rules.

For details, see the following topics:

- Alert organization and properties
- <Specific Log File Rule Name>
- ActionNotRun
- AS_AverageProcedureDurationHigh
- AS_BrokerAbnormalShutdown
- AS_BrokerNormalShutdown
- AS_BrokerStartup
- AS_ClientAbnormalDisconnect
- AS_NameServerUnavailable
- AS_QueueRequestPercentHigh
- AS_RejectedRequestPercentHigh
- AS_ServerAdded
- AS_ServerKilled
- AS_ServerTrimmed
• AS_ServerUnavailable
• BadSearchPattern
• ContextSwitchHigh
• CPUBusyThresholdExceeded
• CPUNotFound
• DB_AbnormalShutdown
• DB_AgentCrash
• DB_AgentDown
• DB_AgentIdle
• DB_AgentReadError
• DB_AgentStartup
• DB_AlWWritePercentLow
• DB_AreaSpaceUtilizationHigh
• DB_AutoStartFail
• DB_BIPartialWritesHigh
• DB_BIWritePercentLow
• DB_BrokerReconnectFail
• DB_BufferIOHigh
• DB_BuffersWithDeletedCheckpointsHigh
• DB_BusyAIBufferWaitsHigh
• DB_BusyBIBufferWaitsHigh
• DB_CheckpointLengthShort
• DB_DatabaseCommitsLow
• DB_DatabaseCrash
• DB_DatabaseDown
• DB_EmptyAIBuffersWaitsHigh
• DB_EmptyBIBufferWaitsHigh
• DB_FathomTrendDatabase
• DB_NormalShutdown
• DB_PartIALBufferWritesHigh
• DB_PhysicalReadHigh
• DB_RequestsToRequestsHigh
• DB_RecordWaitsHigh
• DB_ResourceAdded
• DB_ResourceDisabled
• DB_ResourceEnabled
• DB_ResourceNameConflict
• DB_Startup
• DB_TrendingStopped
• DB_UserCountHigh
• DB_VariableAreaExtentGrow
• DiminishedFileGrowth
• DiskAvgQueueHigh
• DiskBusyThresholdExceeded
• DiskNotFound
• ExcessiveFileGrowth
• FathomTrendingUnavailable
• FileDoesNotExist
• FileExists
• FileIsDirectory
• FileModified
• FileSizeEqual
• FileSizeExceeded
• FileSizeLow
• FileSizeNotEqual
• FileStale
• FileSystemNotFound
• FileSystemUsedThresholdExceeded
• HTTPDownloadFailure
• HTTPRedirect
• InvalidProgressVersion
• JobStartFailure
• LatchWaitCountHigh
• LogActionWriteError
• LogFileIOException
• LogFileNotFound
• MalformedPattern
• MalformedURL
• MemoryNotFound
• MS_BrokerAbnormalShutdown
• MS_BrokerNormalShutdown
• MS_BrokerStartUp
• MQA_BrokerAbnormalShutdown
• MQA_BrokerNormalShutdown
• MQA_BrokerStartUp
• NetworkResourceFailure
• NetworkResourceTardy
• NetworkResourceTimeout
• NetworkResourceUnreachable
• NoContentInPage
• NoSearchCriteria
• NS_AbnormalShutdown
• NS_ApplicationServiceNotFound
• NS_BrokerRegistrationFailure
• NS_BrokerTimeout
• NS_ClientRequestRejected
• NS_DuplicateBrokerUUID
• NS_NameServerReregisteredBroker
• NS_NormalShutdown
• NS_Startup
• OD_BrokerAbnormalShutdown
• OD_BrokerNormalShutdown
• OD_BrokerStartUp
• OR_BrokerAbnormalShutdown
• OR_BrokerNormalShutdown
• OR_BrokerStartUp
• PageContentChanged
• ProcessCPUBusyThresholdExceeded
• ProcessPhysicalMemoryThresholdExceeded
• ProcessVirtualMemoryThresholdExceeded
• ProjectCreated
• ProjectLoadFailed
• ProjectNoRead
• ProjectUpgraded
• ProjectVersionLater
• ReportRunFailed
• ResrcDoesNotExist
• RunQueueHigh
• SearchPatternFound
• SearchPatternNotFound
• SystemMemoryUsedThresholdExceeded
• TaskInQueueFailure
• TaskExecFailure
• TaskLocalDBAssocError
• TaskQueueFull
• TaskRemoteDBAssocError
• TaskRunError
• TaskStderrListenerFailed
• TaskStdinReadFailed
• TaskWaitFailure
• TemplateNotLoaded
• TimerExpired
• VirtualMemoryUsedThresholdExceeded
• WS_AgentAdded
• WS_AgentKilled
• WS_AgentTrimmed
• WS_AgentUnavailable
• WS_AverageProcedureDurationHigh
• WS_BrokerAbnormalShutdown
• WS_BrokerNormalShutdown
• WS_BrokerStartup
• WS_NameServerUnavailable
• WS_QueuedRequestPercentHigh
• WS_RejectedRequestPercentHigh
• WSA_StartUp
• WSA_ShutDown

Alert organization and properties

For ease of reference, some of the alerts are listed in alphabetical order by prefix. The alerts related to the database and OpenEdge appear in this text with the unique prefixes listed in the following table.

Table 10: Alert type prefixes

<table>
<thead>
<tr>
<th>Alert type</th>
<th>Prefix</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppServer</td>
<td>AS_</td>
</tr>
<tr>
<td>Database</td>
<td>DB_</td>
</tr>
<tr>
<td>NameServer</td>
<td>NS_</td>
</tr>
<tr>
<td>WebSpeed</td>
<td>WS_</td>
</tr>
<tr>
<td>Microsoft SQL DataServer</td>
<td>MSS_</td>
</tr>
<tr>
<td>ODBC DataServer</td>
<td>OD_</td>
</tr>
<tr>
<td>Oracle DataServer</td>
<td>OR_</td>
</tr>
<tr>
<td>AppServer Internet Adapter</td>
<td>AIA_</td>
</tr>
<tr>
<td>SonicMQ Adapter</td>
<td>MQA_</td>
</tr>
<tr>
<td>Web Services Adapter</td>
<td>WSA_</td>
</tr>
<tr>
<td>OE Web Server</td>
<td>RESTMGR1_</td>
</tr>
<tr>
<td>Messengers</td>
<td>MSNGR_</td>
</tr>
</tbody>
</table>

Report alerts related to report run failures are preceded by the prefix ReportRunFailed. Alerts that do not have a prefix are listed alphabetically by name.

Alert properties

This chapter presents one or more of the following property details for alerts:

• **Name** — The name of the alert. In those instances in which the specific alert name might vary, the alert is identified in this chapter with brackets (< >).
• **Message** — What the alert looks like to the recipient. Variables that appear in alert messages are identified in this reference section in italics. For example, Broker: *name*, NameServer: *NSname*, and Threshold: *threshold*.

• **Description** — A description of the alert.

• **Type** — The type of alert: polled or asynchronous. See Alert types on page 21 for a detailed definition for each alert type.

• **Action** — Suggestions on what remedial actions to take.

• **Note** — Additional clarifying information about an alert.

• **See Also** — References to other manuals. These references might provide additional details about an alert, or about related functionality.

You might not see all elements listed for every alert; elements are listed if applicable.

**<Specific Log File Rule Name>**

**Message**

*<rulename>*: Text found in *<file being monitored>*. Rule name (# of matches): %s

**Description**

Sent when the log file monitor finds one or more strings in file *x*, where *x* is the file being monitored.

**Type**

Synchronous

**Note**

The Log File Monitor found a string or strings in the log file it is monitoring. The strings have the Log File Rule name and a number in brackets. The number represents the number of times the search string was found in a poll. The string name is the name of the rule associated with the active monitoring plan, not the search string itself.

**ActionNotRun**

**Message**


**Description**

Sent when an action running in response to an alert fails due to an error. It is possible that this alert can be triggered when the Action Queue is full, indicating that when actions are invoked they are not being completed due to this full state.
Type
Asynchronous

Action
Contact Progress Software Corporation Technical Support.

Notes
- If you receive this alert, any recovery or notification that the action was to perform will not have occurred.
- If the thread pool or queue used to run the action overflows, this alert is generated.

**AS_AverageProcedureDurationHigh**

**Message**
"The average execution time of a procedure has exceeded the threshold. Threshold: threshold Current Value: Current value Procedure: Procedure name."

**Description**
The average time spent executing a procedure during the polling interval exceeded the threshold. This situation could indicate a bottleneck in the application or other unforeseen events that inhibit the offending procedure from executing as quickly as expected.

**Type**
Polled

**See Also**
*OpenEdge Management: Servers, DataServers, Messengers, and Adapters*

**AS_BrokerAbnormalShutdown**

**Message**
"AppServer broker shut down abnormally. Broker: name."

**Description**
Sent when an AppServer broker shut down abnormally (crashed).

**Type**
Asynchronous

**Action**
View the appropriate log file for further information.
AS_BrokerNormalShutdown

**Message**
"AppServer broker shutdown normally. Broker: name."

**Description**
Sent when an AppServer broker shuts down normally.

**Type**
Asynchronous

AS_BrokerStartup

**Message**
"AppServer broker started. Broker: name."

**Description**
Sent when an AppServer broker starts up.

**Type**
Asynchronous

AS_ClientAbnormalDisconnect

**Message**
"A client is disconnected abnormally. Message: disconnectMsg."

**Description**
Sent when an AppServer client connection is abnormally dropped.

**Type**
Asynchronous
**AS_NameServerUnavailable**

**Message**
"AppServer broker failed to reach the NameServer. Broker: name, NameServer: NSName."

**Description**
Sent when the AppServer broker failed to contact the NameServer.

**Type**
Asynchronous

**Action**
Check the AdminServer log (`admserv.log`) for more information about NameServer unavailable.

**AS_QueuedRequestPercentHigh**

**Message**
"The percentage of queued requests has exceeded the threshold. Current Value: value, Threshold: threshold, Broker:name."

**Description**
The percentage of client requests queued during the polling interval exceeded the threshold. This situation could indicate bottlenecks or other unforeseen events that are slowing down request processing.

**Type**
Polled

**Action**
Check the AdminServer log (`admserv.log`) for further information about RequestQueueDepthHigh.

**See Also**
OpenEdge Management: Servers, DataServers, Messengers, and Adapters

**AS_RejectedRequestPercentHigh**

**Message**
"The percentage of rejected requests has exceeded the threshold. Broker: name, Current Value: value%, Threshold: threshold%."
Description
The percentage of client requests rejected during the polling interval exceeded the threshold. This situation could indicate bottlenecks or tuning problems, preventing client requests from being serviced.

Type
Polled

Action
Check the AdminServer log (admserv.log) for further information about Client Request Rejected and No Available Server.

See Also
OpenEdge Management: Servers, DataServers, Messengers, and Adapters

AS_ServerAdded

Message
"AppServer broker added server(s). Broker: name, Number of servers added: num."

Description
Sent when AppServer servers have been added to the pool of available servers.

Type
Asynchronous

AS_ServerKilled

Message
One of two messages can appear for this alert:
• "Server killed. Server PID: PID."
• "Server cannot be killed at this time. Server PID: PID."

Description
Sent when a user manually destroys an AppServer or AppServers. Typically a user initiates a server kill action when servers hang under a connecting status for a long time.

Type
Asynchronous
**Action**
If the kill request cannot be processed, check the log file.

**See Also**
*OpenEdge Management: Servers, DataServers, Messengers, and Adapters*

---

**AS_ServerTrimmed**

**Message**
"AppServer broker trimmed server(s). Broker: name, Number of servers trimmed: num."

**Description**
Sent when AppServer servers have been trimmed from the pool of available servers.

**Type**
Asynchronous

**See Also**
*OpenEdge Management: Servers, DataServers, Messengers, and Adapters*

---

**AS_ServerUnavailable**

**Message**
"The server has been in an unavailable state for more than specified number of polls. Threshold: threshold, Number of polls: number of polls, PID: process ID."

**Description**
Sent when a server has been unavailable for more than the specified number of polls.

**Type**
Polled

**Action**
Check the AdminServer log *(admserv.log)* for further information about ServerUnavailableTimeout.
BadSearchPattern

Message
"The search pattern provided to the HTTP Monitor's content rule is malformed. Pattern: x."

Description
Sent if the HTTP Monitor could not search downloaded content because the pattern provided did not follow the rules for regular expressions.

Type
Polled

ContextSwitchHigh

Message
"Upgrade record locks are n. The current threshold is threshold."

Description
Sent to identify the number of times that the CPU has to switch between processes, saving the state of that process, including memory information, to ensure that it can restart that process exactly where it left off.

Type
Polled

Action
Review CPU and memory activity to determine if they are overloaded.

Note
Content switches not only deal with CPU, but also with memory consumption, paging, and swapping.

CPUBusyThresholdExceeded

Message
"CPU Busy Threshold Exceeded! Value: x, Threshold: y."

Description
Sent when a CPU's configured threshold is exceeded.
Type
Polled

Action
If the CPU Busy percent is continuously above the defined threshold, look for race conditions in individual processes and reduce the number of active applications. If necessary, consider upgrading the CPU to a faster model.

**CPUNotFound**

**Message**
"Cannot obtain information about the CPU resource."

**Description**
Sent when the CPU monitor fails to obtain valid query information for the CPU resource.

**Type**
Asynchronous

**Action**
Because the CPU monitor cannot locate the underlying CPU resource, the CPU monitor is unable to obtain information about the CPU activity. This might be related to a problem with one or more CPUs on the machine or a problem with the machine-specific library used to monitor the system resources. Check the AdminServer log (`admserv.log`) to see if the osmetrics shared library has logged errors while initializing or during operation.

**DB_AbnormalShutdown**

**Message**
"Abnormal shutdown has occurred for database x."

**Description**
Sent when the DB_agent detects the death of the database broker.

**Type**
Asynchronous

**Action**
Check the database log file for additional information regarding the abnormal shutdown.
Note
An abnormal shutdown occurs when the database crashes or the shutdown is performed with Proshut instead of Dbman. (The `Dbman` command is initiated through the AdminServer, enabling the AdminServer to be aware of the shutdown activity. The `Proshut` command communicates directly with the database server, causing the AdminServer to assume that the database has abnormally shut down.)

**DB_AgentCrash**

**Message**
"Database Agent, x, crashed!"

**Description**
Sent when the database monitoring agent crashes. If the agent is not running, database monitoring cannot occur.

**Type**
Asynchronous

**Action**
Check that the database agent is still running. If it is not, restart it.

**DB_AgentDown**

**Message**
"Database agent, x, is shutting down."

**Description**
Sent when a database agent is shut down. If the agent is not running, database monitoring cannot occur.

**Type**
Asynchronous

**Action**
If the agent should be running, restart it.

**DB_AgentIdle**

**Message**
"Database Agent, x, is not running."
Description
Sent when a database agent is not running but the database resource is enabled. If the agent is not running, database monitoring cannot occur.

Type
Asynchronous

Action
Go to the Database Control page for the affected database and start the agent.

DB_AgentReadError

Message
"A problem was encountered getting data from database x. The data will be ignored."

Description
Sent when a problem was encountered with retrieving VST data during the polling of the database. No rules will be evaluated.

Type
Asynchronous

DB_AgentStartup

Message
"A normal string has occurred for database agent, x."

Description
Sent when a database agent starts.

Type
Asynchronous

DB_AIWWritePercentLow

Message
"After-image writer percentage is n. The current threshold is x. Sample number = y."
**DB_AreaSpaceUtilizationHigh**

**Description**
Sent when the percentage of used blocks in area $X$ is high.

**Message**
"Area $X$ is $n\%$ utilized. The threshold is $x$."

**Description**
Sent when the percentage of used blocks in area $X$ is high.

**Type**
Polled

**Note**
Information about DB_AreaSpaceUtilizationHigh is stored in the OpenEdge Management Trend Database.

**See Also**
For additional database-related information, see:

- *OpenEdge Management: Trend Database Guide and Reference*
- *OpenEdge Data Management: Database Administration*

---

**DB_AutoStartFail**

**Message**
"Database $x$ has failed to start."
Description
Sent when the database is configured to start automatically when the AdminServer starts, but does not.

Type
Asynchronous

Action
Check the database log file for additional information regarding the failed start.

DB_BIPartialWritesHigh

Message
"Before-image partial writes are n. The current threshold is x."

Description
Sent when the number of partial writes of before-image buffers to the before-image file is above the threshold.

Type
Polled

Action
Decrease -biblocksize parameter to next size down or increase -Mf.

Note
Information about DB_BIPartialWritesHigh is stored in the OpenEdge Management Trend Database in the Db_ActLog table.

DB_BIWWritePercentLow

Message
"Before-image writer percentage is n. The current threshold is x."

Description
Sent when the database before-image writer write percentage is below the threshold.

Type
Polled

Action
Lower BI block size.
Notes:
• If the database license is Workgroup, BIW is disabled and cannot be enabled.
• Information about BIWWritePercentLow is stored in the OpenEdge Management Trend Database in the Db_ActLog table.

DB_BrokerReconnectFail

Message
"Database broker for the specified database failed to reconnect when the AdminServer was started."

Description
Sent when the database broker was connected and running when the AdminServer was stopped, and failed to reconnect when the AdminServer was restarted.

Type
Asynchronous

DB_BufferIOHigh

Message
"Database I/O is unusually high. The write-to-I/O ratio is x. The current threshold is y."

Description
Sent when database writes-to-read ratio is above average.

Type
Polled

Action
Review database layout and disk subsystem performance.

Note
Information about BufferIOHigh is stored in the OpenEdge Management Trend Database in the Db_ActSum table.
**DB_BuffersFlushedatCheckpointHigh**

**Message**
"Buffers flushed at checkpoint were \( n \). The current threshold is \( x \)."

**Description**
Sent if there are database buffers that were flushed at checkpoint.

**Type**
Polled

**Action**
Verify that APWs are running. Increase the BI cluster size. Start additional APWs if only one is running.

**Notes**
- If the database is a licensed workgroup, APW is disabled and cannot be enabled.
- Starting additional APWs can be automated on managed databases.
- The database must be down before the BI cluster size can be changed.
- Information about BuffersFlushedatCheckpointHigh is stored in the OpenEdge Management Trend Database in the Db_ActBuf and Db_Checkpoint tables.

**DB_BusyAIBufferWaitsHigh**

**Message**
"After-image busy buffer waits are \( n \). This is above the threshold. The current threshold is \( x \)."

**Description**
Sent when database after-image busy buffer waits are above the defined threshold.

**Type**
Polled

**Action**
Raise AI block size.

**Note**
Information about BusyAIBufferWaitsHigh is stored in the OpenEdge Management Trend Database in the Db_ActLog table.
DB_BusyBIBufferWaitsHigh

Message
"Waits for busy before-image buffers is \( n \). The current threshold is \( x \)."

Description
Sent when the waits for busy before-image buffers percentage is above the threshold.

Type
Polled

Action
Verify that the BI block size is adequate.

Note
Information about BusyBIBufferWaitsHigh is stored in the OpenEdge Management Trend Database in the Db_ActLog table.

DB_CheckpointLengthShort

Message
"Checkpoint length is \( n \) seconds. The current threshold is \( x \) seconds."

Description
Sent when the database checkpoint length is below the threshold.

Type
Polled

Action
Increase the BI cluster size.

Notes
• If the database license is Workgroup, the BIW is disabled and cannot be enabled.
• Information about CheckpointLengthShort is stored in the OpenEdge Management Trend Database in the Db_Checkpoint table.
• The database must be down before the -BI clusters can be changed.
**DB_DatabaseCommitsLow**

**Message**
"Database commits are \( n \). The current threshold is \( x \)."

**Description**
Sent when database commits are below the threshold.

**Type**
Polled

**Action**
Make sure that adequate database activity has occurred for this sample.

**Note**
Information about DatabaseCommitsLow is stored in the OpenEdge Management Trend Database in the Db_ActSum table.

**DB_DatabaseCrash**

**Message**
"Database Broker, x, crashed!"

**Description**
Sent when the database broker crashes.

**Type**
Asynchronous

**DB_DatabaseDown**

**Message**
"Database Broker, x, is shutting down."

**Description**
Sent when a database broker is shut down.
DB_EmptyAIBuffersWaitsHigh

**Type**  
Asynchronous

**Note**  
This alert is informational only.

**Message**  
"After-image buffers unavailable are \( n \). The current threshold is \( x \)."

**Description**  
Sent when there are no database after-image buffers available.

**Type**  
Polled

**Action**  
Increase the \(-aibufs\) startup parameter.

**Note**  
Information about EmptyAIBuffersWaitsHigh is stored in the OpenEdge Management Trend Database in the Db_ActLog table.

---

DB_EmptyBIBufferWaitsHigh

**Message**  
"Wait percentage for empty before-image buffers is \( n\%\). The current threshold is \( x\)."

**Description**  
Sent when wait percentage for empty before-image buffers is above the threshold.

**Type**  
Polled

**Action**  
Increase the Before-image Buffers \((-bibufs)\) startup parameter.

**Note**  
Information about EmptyBIWaitsHigh is stored in the OpenEdge Management Trend Database in the Db_ActLog table.
DB_FathomTrendDatabase

**Message**
"The database at database location does not match the FathomTrendDatabase schema."

**Description**
Sent when the database running at the port specified for the OpenEdge Management Trend Database is not an OpenEdge Management Trend Database.

**Type**
Asynchronous

**Action**
Specify another port, or stop the database running at that port and start the OpenEdge Management Trend Database.

DB_NormalShutdown

**Message**
"A normal shutdown has occurred for database x."

**Description**
Sent when normal database shutdown has completed.

**Type**
Asynchronous

**Action**
Check the database log file for additional information regarding the shutdown.

DB_PartialAIBufferWritesHigh

**Message**
"After-image partial write percentage is n%. The current threshold is x%."

**Description**
Sent when the database after-image buffer partial writes are above the threshold.
DB_PhysicalReadHigh

**Message**
"Database physical to logical read ratio is n. The current threshold is x." 

**Description**
Sent when the database physical-to-logical read ratio is above the threshold.

**Type**
Polled

**Action**
Increase database buffers (-B) startup parameter.

**Note**
Information about PhysicalReadHigh is stored in the OpenEdge Management Trend Database in the Db_ActBuf table.

DB_ReadsToRequestsHigh

**Message**
"Database reads to requests percentage is n. The current threshold is x." 

**Description**
Sent when the database Read to Request percentage is unusually high.

**Type**
Polled

**Action**
Review User Requests and User Reads to ensure proper ratios.
Note
Information about DatabaseReadstoRequestsHigh is stored in the OpenEdge Management Trend Database in the Db_ActSum table.

DB_RecordWaitsHigh

Message
"The percentage of waits for records is n%. The current threshold is x%. Exclusive=a%. Share=b%. Upgrade=c%. RecGet=d%.

Description
Sent when waits for records are above the threshold.

Type
Polled

Action
Review what users hold share and exclusive locks by querying the _ActLock and _UserLock VSTs.

Note
Information about RecordWaitsHigh is stored in the OpenEdge Management Trend Database in the Db_ActRec table.

DB_ResourceAdded

Message
"Database Resource, x, added."

Description
Sent when a managed database object is created.

Type
Asynchronous

Note
This alert is informational only.
**DB_ResourceDisabled**

**Message**
"Database Resource, x, disabled."

**Description**
Sent when a database resource is disabled.

**Type**
Asynchronous

**Note**
This alert is informational only.

**DB_ResourceEnabled**

**Message**
"Database Resource, x, enabled."

**Description**
Sent when a database resource is enabled.

**Type**
Asynchronous

**Note**
This alert is informational only.

**DB_ResourceNameConflict**

**Message**
"Cannot create database resource. A database resource with this name already exists."

**Description**
Sent when you create a database configuration that has the same name as an existing OpenEdge Management database resource. As a result, OpenEdge Management could not create a database resource for the new database configuration.
Type
Asynchronous

Action
Be sure to give each OpenEdge Management resource a unique name.

DB_Startup

Message
"A startup has occurred for database x."

Description
Sent when a database startup has been detected.

Type
Asynchronous

DB_TrendingStopped

Message
"Trending information has stopped being gathered for database n."

Description
Sent when trending information has stopped being gathered for a database.

Type
Asynchronous

Action
Check the AdminServer log file (admserv.log) for additional information.

Note
The gathering of trending information stops when the database is shut down, the Db_agent is disconnected from the database, or the trending flag is turned off.
DB_UserCountHigh

Message
"The user count for the specified database has exceeded the threshold. Threshold: x, User Count: y."

Description
Sent when the defined user count threshold is exceeded.

Type
Polled

DB_VariableAreaExtentGrow

Message
"Extent ExtentName has extended more than 3 times in this sample. The threshold is x."

Description
Sent when a database variable-length data or before-image extent extends.

Type
Polled

Action
Add an additional fixed-length extent.

Note
Information about VariableAreaExtentGrow comes from the _ActIOFile VST.

See Also
OpenEdge Data Management: Database Administration for details about how to add an extent.

DiminishedFileGrowth

Message
"The file is growing slower than the specified rate." file: + filename.

Description
Sent when the growth rate specified on the File Growth Rate rule has not been met.
DiskAvgQueueHigh

**Message**
"Disk average queue length is $n$. The current threshold is $threshold$."

**Description**
Sent to inform the user of the average number of processes in the queue for disk activity. This information can be reads or writes. However, it is typically expressed as reads.

**Type**
Polled

**Action**
Review the disk performance information, disk system layout, and application use of disk.

DiskBusyThresholdExceeded

**Message**
"Disk Busy Threshold Exceeded! Value: $x$, Threshold: $y$."

**Description**
Sent when a disk's configured threshold is exceeded.

**Type**
Polled

**Action**
Consider the following options to reduce the disk's load:
• Spread databases across multiple disks which will increase the Blocks in database buffers ($-B$ parameter).
• Add more disks.
• Request that your system administrator invest in faster disks.

**Notes**
• Adding more disks to a system increases overall disk I/O because reads and writes can span across multiple disks. However, the performance results depend on how the multiple disks are grouped and how you structure your databases.
• For information on how your OpenEdge databases affect disk I/O, view the following OpenEdge VSTs:
• _ActBuffer._Buffer-OSRds — Displays information about the number of database block reads from disk
• _ActBuffer._Buffer-OSWrts — Displays information about the number of database block writes to disk
• _ActIOType — Displays information about types of input/output activity, such as database reads and writes, BI and AI reads, total reads, BI and AI writes, and committed transactions
• _ActIOFile — Displays information about input/output activity, including the number of reads, writes, and extends for each file

DiskNotFound

Message
"Cannot obtain information about the disk resource."

Description
Sent when the disk monitor fails to obtain valid query information for the disk resource.

Type
Asynchronous

Action
Because the disk monitor cannot locate the underlying disk resource, the disk monitor is unable to obtain information about the disk usage. This might be related to a problem with the disk itself or with the machine-specific library used to monitor the system resources.

Check the AdminServer log file (admserv.log) to see if the osmetrics shared library has logged errors while initializing or during operation.

ExcessiveFileGrowth

Message
"The file is growing faster than the specified rate." file: + filename.

Description
Sent when the growth rate specified on the File Growth Rate rule has been exceeded.

Type
Polled
FathomTrendingUnavailable

**Message**
"Fathom cannot reach the trend database at machine name:port number. Check the log file for more information."

**Description**
Sent when OpenEdge Management cannot reach the defined trend database at the specified HTTP port.

**Type**
Asynchronous

**Action**
Check the AdminServer log (admserv.log) file on the specified machine for more information. Use the note information below for starting points.

**Note:**
This alert triggers if:
• OpenEdge Management is not running on the trending database's machine.
• The specified location does not have a local trend database defined.
• The trend database is not running at the specified location.
• There is a communication problem between machines.

FileDoesNotExist

**Message**
"The file does not exist."

**Description**
Sent when the file resource monitor cannot find the file specified as a file size resource.

**Type**
Polled

**Action**
Check the file size resource's path. If the path is correct but the file is missing, restore the file from backup.
FileExists

Message
"The specified file exists. File: x."

Description
Sent when a user specifies that a file monitor alert should be used to indicate that a file exists.

Type
Polled

FileIsDirectory

Message
"The file specified is a directory."

Description
Sent when the file specified for a file resource is a directory.

Type
Polled

Note
The size of a directory is reported as zero-length. Because of this, the file resource monitor treats the directory's status as passed, regardless of the type of comparison specified in the monitor's rules.

FileModified

Message
"The file was modified. file:filename"

Description
Sent when the file has been modified and the File Modified rule has been configured.

Type
Polled
FileSizeEqual

Message
"The file size is equal to the specified size. Actual size: x, Specified Size: x."

Description
Sent when the file size monitor detects that a file's size is equal to its configured value.

Type
Polled

Action
Take necessary remedial actions to correct the file size.

FileSizeExceeded

Message

Description
Sent when a file size monitor detects that the file exceeded its configured size.

Type
Polled

Action
Take any necessary actions to correct the file size, such as truncating the file.

FileSizeLow

Message
"The file size is less than the specified size. Actual Size: x, Specified Size: y."

Description
Sent when the file size monitor detects that a file is less than its specified size.
FileSizeNotEqual

Message
"The file size does not equal the specified size. Actual Size: x, Specified Size: y."

Description
Sent when a file size resource fails because its size does not equal its configured size.

Type
Polled

Action
Take necessary remedial actions to correct the file size.

FileSizeStale

Message
"The file is older than the age specified. file:filename."

Description
Sent when the file age specified by the File Age Rule has been exceeded.

Type
Polled

FileSystemNotFound

Message
"Cannot obtain information about the file system resource."

Description
Sent when the file system monitor fails to obtain valid query information for the file system resource.
Type
Asynchronous

Action
Because the file system monitor cannot locate the underlying file system resource, the file system monitor is unable to obtain information about file system usage. This might be related to a problem with the file system itself or with the machine-specific library used to monitor the system resources.

Check the AdminServer log (admserv.log) to see if the osmetrics shared library has logged errors while initializing or during operation.

FileSystemUsedThresholdExceeded

Message
"FileSystem Used Threshold Exceeded! Value: x, Threshold: y."

Description
Sent when a file system's configured threshold is exceeded.

Type
Polled

Action
Free up space on the file system by deleting unnecessary files; create a multivolume database, or update existing multivolume databases.

Notes
• OpenEdge Management gathers file system information primarily for trend analysis. The FileSystemUsedThresholdExceeded alert can help you prevent trouble caused by lack of disk space.
• The RDBMS VST _AreaStatus displays data about the status of areas. Use the information in the _AreaStatus VST, along with the file system information trended by OpenEdge Management, to predict when it is time to extend or redesign your database. Viewing the information in your database’s _AreaExtents record can also help track database file growth.

HTTPDownloadFailure

Message
"OpenEdge Management failed to retrieve the specified Web page. URL: The URL of the page Fathom attempted to download, HTTP Response Code: The response code reported by the Web server."

Description
Sent when OpenEdge Management cannot download the URL provided to an HTTP monitor.
HTTPRedirect

**Type**
Polled

**Action**
The reason why the attempted download failed is given in the response code. Refer to RFC 2616 for information about specific values.

**HTTPRedirect**

**Message**
"The monitored page was redirected. Monitored URL: *the URL being monitored by Fathom*, Retrieved URL: *the URL actually downloaded by Fathom.*"

**Description**
Sent when the URL provided to an HTTP monitor is redirected to another location, and you have chosen to alert on this condition.

**Type**
Polled

InvalidProgressVersion

**Message**
"OpenEdge Management is bound to an unsupported Progress version or patch level. Current Progress Version: *version string*, Minimum Required Progress Version or Patch Level: *version string.*"

**Description**
Sent when OpenEdge Management detects that the OpenEdge version is unsupported or not at the right patch level.

**Type**
Asynchronous

**Action**
Update to the identified OpenEdge version or patch level.
JobStartFailure

Message
"Unable to execute the job as an action. Job: x."

Description
Sent when a job that was specified as the alert action for a resource does not execute.

Type
Asynchronous

Action
Check the log file for additional information regarding the failure of the job.

LatchWaitCountHigh

Message
"Latch waits for latch latchname are n. The current threshold is threshold."

Description
Sent when the number of latch counts is above the threshold.

Type
Polled

Action
Review which users are accessing and using the latches. Review the –spin setting for the database.

Note
These details reflect a per-latch basis. There are 31 latches for a database. There can be more than one latch for this rule, and each latch should be a separate rule that must be evaluated.

LogActionWriteError

Message
"There was a problem writing to the log file. Check that the directory exists and the file is writable. File: the file to which the action is attempting to write."
LogFileIOException

Description
Sent if a log action cannot write to the indicated file.

Type
Asynchronous

Action
Check to make sure that the directory exists and that the file has write permissions.

LogFileIOException

Message
"The Log File Monitor could not open or write to the name of log file being monitored."

Description
Sent when the log file monitor encounters an input/output exception with the file specified in the Filename Input parameter.

Type
Synchronous

Action
Check the file's permissions to make sure that the AdminServer's rights match the file's rights; if they do not, the monitor will not be able to open it. Also check the directory's permissions.

Note
This alert fires when the log file monitor has trouble opening the file or has permissions problems. An interruption in I/O stream can also trigger this alert.

LogFileNotFound

Message
"Name of monitored file was not found."

Description
Sent when the log file monitor cannot find the file specified in the Filename Input parameter.

Type
Synchronous
**Action**
Make sure the file exists in the specified directory.

**Note**
This alert is generated only when the log file monitor cannot find the file, not when the file is found but cannot be opened.

---

**MalformedPattern**

**Message**
"The Log File Monitor could not understand the regular expression syntax given in one of its Search Criteria. Pattern and name of Search Criteria in which the error occurred."

**Description**
Sent when the log file monitor encounters an error with the Search Text listed in its Search Criteria.

**Type**
Synchronous

**Action**
Make sure the syntax given in the Search Text field is valid Perl 5 regular expression syntax.

**See Also**
OpenEdge Management: Resource Monitoring for details about valid Perl 5 regular expression syntax.

---

**MalformedURL**

**Message**
"The defined URL monitor has a malformed, or incorrect, URL in its definition. The URL should be changed to reflect a valid URL."

**Description**
The URL for the HTTP resource is malformed.

**Type**
Polled
MemoryNotFound

**Message**
"Cannot obtain information about the memory resource."

**Description**
Sent when the memory resource monitor fails to obtain valid query information for the memory resource.

**Type**
Asynchronous

**Action**
Because the memory monitor cannot locate the underlying memory resource, the memory monitor is unable to obtain information about the memory usage. This might be related to a problem with one or more memory boards on the machine or with the machine-specific library used to monitor the system resources.

Check the AdminServer log file (`admserv.log`) to see if the osmetrics shared library has logged errors while initializing or during operation.

MS_BrokerAbnormalShutdown

**Message**
"MSS DataServer broker shut down abnormally. Broker: name."

**Description**
Sent when a Microsoft SQL Server broker shut down abnormally (crashed).

**Type**
Asynchronous

**Action**
View the appropriate log file for further information.

MS_BrokerNormalShutdown

**Message**
"MSS DataServer broker shutdown normally. Broker: name."
Description
Sent when a Microsoft SQL Server broker shuts down normally.

Type
Asynchronous

MS_BrokerStartUp

Message
"MSS DataServer broker started up. Broker: name."

Description
Sent when a Microsoft SQL Server broker starts up.

Type
Asynchronous

MQA_BrokerAbnormalShutdown

Message
"SonicMQ Adapter broker shut down abnormally. Broker: name."

Description
Sent when a SonicMQ Adapter broker shut down abnormally (crashed).

Type
Asynchronous

Action
View the appropriate log file for further information.

MQA_BrokerNormalShutdown

Message
"SonicMQ Adapter broker shutdown normally. Broker: name."

Description
Sent when a SonicMQ Adapter broker shuts down normally.
**MQA_BrokerStartUp**

**Type**
Asynchronous

**Message**
"SonicMQ Adapter broker started up. Broker: name."

**Description**
Sent when a SonicMQ Adapter broker starts up.

**Type**
Asynchronous

**NetworkResourceFailure**

**Message**
"The network resource failed to respond."

**Description**
Sent when a network resource fails to respond.

**Type**
Asynchronous

**Action**
Verify that the service on the monitored machine is running.

**Note**
If the resource being monitored is a TCP or UDP port, this alert indicates only that the port cannot be accessed, not that the machine on which the port exists is unavailable. This alert is never generated for an ICMP monitor, as ICMP monitors do not use ports.

**NetworkResourceTardy**

**Message**
"The tardy threshold has been exceeded. A response time that is greater than the tardy threshold, but less than the timeout threshold will result in the resource status being reported as tardy."
**Description**  
Sent when the network resource response time exceeded the tardy threshold.

**Type**  
Polled

## NetworkResourceTimeout

**Message**  
"The timeout threshold has been exceeded. Response: resource response time ms, Threshold: timeout threshold ms."

**Description**  
Sent when the network resource response time exceeded the timeout threshold.

**Type**  
Polled

## NetworkResourceUnreachable

**Message**  
"The network resource is unreachable."

**Description**  
Sent when the network resource cannot be reached, such as after attempts to ping the resource were unsuccessful.

**Type**  
Asynchronous

**Action**  
Check the network connection on the machine you want to access, as well as the machine that OpenEdge Management is on. If the network connections appear fine, contact your network administrator.

## NoContentInPage

**Message**  
"The HTML page could not be searched because no content was retrieved."
NoSearchCriteria

Message
"The Log File Monitor does not have any Search Criteria associated with it."

Description
Sent when the log file monitor does not have any search criteria associated with it.

Type
Synchronous

Action
Edit the Log File Monitor, making sure to define search criteria.

Note
The Log File Monitor must have at least one search criterion associated with it.

NS_AbnormalShutdown

Message
"The NameServer shutdown abnormally. NameServer: name, Port: port."

Description
The NameServer shut down abnormally.

Type
Asynchronous

Action
Examine the NameServer, broker, and AdminServer log files for any additional information to assist you in determining why the NameServer shut down in this manner.
**NS_ApplicationServiceNotFound**

**Message**

"Application Service requested by client not found. Application Service: name, Client host: host, Port: port."

**Description**

Sent when there are no AppServers registered at the NameServer for the Application Service requested by a client.

**Type**

Asynchronous

**Action**

If the Application Service requested is valid, examine the NameServer and Broker log files to determine why a broker is not registered for the requested AppService.

**NS_BrokerRegistrationFailure**

**Message**


**Description**

The identified Broker was not registered for the requested Application Service. The named Application Service already has a broker registered for it, and the Load Balancing option is not installed.

**Type**

Asynchronous

**Action**

See if the broker's list of supported Application Services conflicts with that of other brokers. Consider installing the load balancing option.

**NS_BrokerTimeout**

**Message**

"The registered broker is not responding. The broker will not be registered. Broker: name."
Description
Sent when a registered broker is not responding.

Type
Asynchronous

Action
Examine the broker's log file for any additional information to assist in determining why the broker is not responding.

NS_ClientRequestRejected

Message
"The client request was rejected due to an incorrect message header, or wrong version information in the client message. Client host: name, Port: port."

Description
The NameServer received a request with bad header information. The header information was incorrect, or the protocol version field within the header contained an unsupported version identifier.

Type
Asynchronous

Action
Determine if the request came from a legitimate NameServer client. If the client is an OpenEdge-based client, ensure that the NameServer version is recent enough to support the version of the client.

NS_DuplicateBrokerUUID

Message

Description
Sent when a broker attempts to register with the NameServer using a UUID that has already been registered by another broker.

Type
Asynchronous
Action
Examine the `ubroker.properties` file for duplicated UUID specifications.

**NS_NameServerReregisteredBroker**

**Message**
"The NameServer has reregistered the broker for consistency. Broker: name, Host: host, Port: port, UUID: uuid."

**Description**
The NameServer detected that the broker has been restarted without the NameServer receiving an unregistered request, or having timed out the broker. To ensure that the values associated with the broker are the latest values, the NameServer has unregistered and reregistered the broker.

**Type**
Asynchronous

**Action**
Determine how the broker is being shut down and why it is not sending an unregistered message to the NameServer. Consider if the timeout that the NameServer is using for the brokers is too long, preventing the NameServer from detecting that a broker is no longer responding.

**NS_NormalShutdown**

**Message**
"The NameServer shutdown normally. NameServer: name, Port: port."

**Description**
The NameServer shut down normally.

**Type**
Asynchronous

**NS_Startup**

**Message**
"The NameServer has been started. NameServer: name, Port: port."
Description
The NameServer has been started.

Type
Asynchronous

OD_BrokerAbnormalShutdown

Message
"ODBC DataServer broker shut down abnormally. Broker: name."

Description
Sent when an ODBC DataServer broker shut down abnormally (crashed).

Type
Asynchronous

Action
View the appropriate log file for further information.

OD_BrokerNormalShutdown

Message
"ODBC DataServer broker shutdown normally. Broker: name."

Description
Sent when an ODBC DataServer broker shuts down normally.

Type
Asynchronous

OD_BrokerStartup

Message
"ODBC DataServer broker started up. Broker: name."

Description
Sent when an ODBC DataServer broker starts up.
Chapter 3: Alerts Reference

Type
Asynchronous

OR_BrokerAbnormalShutdown

Message
"Oracle DataServer broker shut down abnormally. Broker: name."

Description
Sent when an Oracle DataServer broker shut down abnormally (crashed).

Type
Asynchronous

Action
View the appropriate log file for further information.

OR_BrokerNormalShutdown

Message
"Oracle DataServer broker shut down normally. Broker: name."

Description
Sent when an Oracle DataServer broker shuts down normally.

Type
Asynchronous

OR_BrokerStartup

Message
"Oracle DataServer broker started up. Broker: name."

Description
Sent when an Oracle DataServer broker starts up.

Type
Asynchronous
PageContentChanged

Message

"The hash code comparison failed on the content retrieved for the URL. URL: The URL for which a hash comparison was made."

Description

Sent if the hash code generated for downloaded Web page content did not match the baseline hash code created on the first poll. This indicates that content that should have been static has changed.

Type

Polled

ProcessCPUBusyThresholdExceeded

Message

"Process CPU Busy Threshold Exceeded! Value: %s, Threshold: %s."

Description

Sent when the percentage of CPU usage being consumed by this process exceeds the set threshold.

Type

Polled

ProcessPhysicalMemoryThresholdExceeded

Message

"Process Physical Memory Used Threshold Exceeded! Value: %s, Threshold: %s."

Description

Sent when the amount of physical memory being consumed by this process exceeds the set threshold.

Type

Polled
ProcessVirtualMemoryThresholdExceeded

Message
"Process Virtual Memory Used Threshold Exceeded! Value: %s, Threshold: %s."

Description
Sent when the amount of virtual memory being consumed by this process exceeds the set threshold.

Type
Polled

ProjectCreated

Message
"Fathom project file not found, new project created."

Description
Sent when OpenEdge Management starts and cannot find the OpenEdge Management project file (fathom.xml).

Type
Asynchronous

ProjectLoadFailed

Message
"Fathom project file could not be loaded. Project file renamed and new project created. Old project file: filename."

Description
Sent when an existing OpenEdge Management project file cannot be loaded at OpenEdge Management start time. The existing OpenEdge Management project file is renamed and a default project file is created.

Type
Asynchronous
ProjectNoRead

**Message**
"Fathom project file cannot be read."

**Description**
Sent when OpenEdge Management starts and cannot read the OpenEdge Management project file (fathom.xml).

**Type**
Asynchronous

**Action**
Check the protections on fathom.xml to make sure Read access is available.

ProjectUpgraded

**Message**
"Fathom project file upgraded for compatibility with current Fathom version."

**Description**
The OpenEdge Management project file was created with an earlier version of OpenEdge Management, and the file has been upgraded for use with the current version of OpenEdge Management. The file is no longer usable by earlier versions of OpenEdge Management.

**Type**
Asynchronous

ProjectVersionLater

**Message**
"Fathom project file version is later than the current Fathom version."

**Description**
Sent when an attempt has been made to load an OpenEdge Management project file (fathom.xml) created with a newer version of OpenEdge Management, and the file cannot be loaded by the current version of OpenEdge Management.
ReportRunFailed

This section identifies the specific message-related text that can appear, indicating a report run has failed. Scan the messages presented in this section to find the one matching the message you received.

To obtain more details related to a report instance for which any ReportRunFailed alert appears:

1. Click Reports. Then choose Defined Reports in the list frame.
2. Select the report instance name in the list frame and display the report definition in the edit mode in the detail frame.
3. Select the Generate debug log file option, resubmit, and rerun the report. It is possible that more log files will display. You can use this data to further investigate your problem.

For more information about reports, see OpenEdge Management: Reporting.

Message
"Output directory not created: <output directory>.

Description
The report engine could not create the necessary directories to store the report output. Check the file system for privileges.

Action
Check the file system for privileges.

Message
"4GL execution error, exit code <return code>. See log files.

Description
The report did not run to completion because of an ABL issue. See the Report Output file (report.out) and the AdminServer log file (admserv.log) for more information.

Action
See the report output log files.

Message
"Graphing request xml file does not exist.

Description
The report failed to complete because there was a problem creating a graph for the report. The _graph.xml file is missing from the report output.
Action
See the log files.

Message
"Report output xml does not exist."

Description
The report failed to complete because the _data.xml file was not created.

Action
See the log files.

Message
"Error writing output file for report. See log files."

Description
There was an I/O error when generating the output file for the report.

Action
See the log files.

Message
"Transformation error. See log files."

Description
The report engine uses XSLT to create the various output formats from the _data.xml. There was an error transforming the XML file to one of the desired output formats.

Action
See the log files.

Message
"Transformation error for HTML output. See log files."

Description
There was an error transforming the data XML file into HTML output using XSLT.

Action
See the log files.

Message
"Transformation error for text output. See log files."

Description
There was an error using XSLT to transform the data XML file into text output.
Action
See the log files.

Message
"SAX parsing error. See log files."

Description
The report failed due to an error parsing an XML file. See the Report Output file (report.out) and the AdminServer log file (admserv.log) for more information.

Action
See the Report Output file (report.out) and AdminServer log file (admserv.log) for more information.

Message
"Graphing error. See log files."

Description
The report failed because the graphing engine had an error producing a graph for the report. See the report output and AdminServer log files (admserv.log) for more information regarding the error.

Type
Asynchronous

Action
See the Report Output file (report.out) and AdminServer log file (admserv.log).

Message
"XSL stylesheet not found: <filename>."

Description
The report failed because it could not find the specified XSL stylesheet to use in transforming the data XML to another output form.

Action
Ensure that the stylesheet is available in the following subdirectory location: OpenEdgeManagement-install-dir/web/report/xsl.

Message
"Report transformation ran out of memory."

Description
The reports use XSL transformations to generate the HTML and text output formats from the XML output that ABL creates. The XML file was too large for the report engine to transform the file, thus the engine ran out of memory. If the report period and/or report format was modified so there is less data in the XML file, the report output will be smaller and the engine will more likely be able to process the file in the amount of memory allotted.
Action
Try reducing the number of columns or rows in the report output by changing the report period or report format.

ResrcDoesNotExist

Message
"The referenced resource, x, does not exist and is referenced by x."

Description
The project file contains a reference to a resource that does not exist.

Type
Asynchronous

RunQueueHigh

Message
"Run queue for CPU is n. The current threshold is threshold."

Description
Sent to identify the number of processes waiting to use the CPU.

Type
Polled

Action
Review what processes are using the CPU. Verify that there is not a runaway process on the system.

SearchPatternFound

Message
"The search pattern was found in the Web page."

Description
Sent if the HTTP monitor located the specified pattern in the downloaded Web page and you have chosen to receive alerts when the pattern is found.
SearchPatternNotFound

Message
"The search pattern was not found in the Web page."

Description
Sent if the HTTP monitor could not locate the specified pattern in the downloaded Web page and you have chosen to receive alerts when the pattern is not found.

SystemMemoryUsedThresholdExceeded

Message
"System Memory Used Threshold Exceeded! Value: x, Threshold: y."

Description
Sent when the system memory's configured threshold is exceeded.

Action
Reduce memory usage by reducing the number of running processes. If necessary, request additional memory from your system administrator.

TaskInQueueFailure

Message
"Unable to schedule task x, already in work queue, exception message y."

Description
Sent when an instance of a report or job is already running when OpenEdge Management attempts to schedule it.
TaskExecFailure

**Type**
Asynchronous

**Message**
"Call to tskExec. exec failed for task: x."

**Description**
Sent when OpenEdge Management encounters a failure when trying to access the OpenEdge Management Trend Database resource.

**Type**
Asynchronous

TaskLocalDBAssocError

**Message**
"Unable to associate local FathomTrendDatabase with task type: task name."

**Description**
Sent when OpenEdge Management encounters a failure when trying to access the local OpenEdge Management Trend Database resource.

**Type**
Asynchronous

TaskQueueFull

**Message**
"Unable to schedule task because the work queue is full. Task: taskname. Exception message: exceptionmsg."

**Description**
OpenEdge Management encountered a failure when it attempted to schedule a job or report to run; the work queue is full.

**Type**
Asynchronous
TaskRemoteDBAssocError

**Message**
"Unable to associate remote FathomTrendDatabase with task type: task name."

**Description**
Sent when OpenEdge Management encounters a failure when trying to access the remote OpenEdge Management Trend Database resource.

**Type**
Asynchronous

TaskRunError

**Message**
"Failed to run task x, exception message y."

**Description**
Sent when OpenEdge Management encounters a failure when trying to run a job or report.

**Type**
Asynchronous

TaskStderrListenerFailed

**Message**
"Unexpected exception starting stderr listener thread in task x, exception message y."

**Description**
Sent when a job, configured to throw an alert if its execution exceeds a predefined time period, does not finish before the timer expires.

**Type**
Asynchronous
TaskStdinReadFailed

Message
"Unexpected exception reading input from task x, exception message y."

Description
Sent when OpenEdge Management failed to read the output of a job or report.

Type
Asynchronous

TaskWaitFailure

Message
"Unexpected exception waiting for task x to complete, exception message y."

Description
Sent when OpenEdge Management encounters a failure when waiting for a job or report to complete.

Type
Asynchronous

TemplateNotLoaded

Message
"Error occurred loading one or more Fathom template files. Not all default resources have been created. See the Fathom log file for detailed information on the import actions that were attempted."

Description
When OpenEdge Management creates a new project file or upgrades an existing project to the latest revision level, it populates the project with a set of default resources. These resources are imported from the templates in the OpenEdge Management template directory.

This error indicates that one or more template files were not imported. Check the AdminServer log file (admserv.log) for more information. The OpenEdge Management import facility can be used interactively to import template files.

Type
Asynchronous
Action
Check the AdminServer log file (admserv.log) for more information. Note that you can use the Import facility interactively to import template files. See the sections on importing and exporting in OpenEdge Management: Resource Monitoring.

TimerExpired

Message
"job name failed to complete in timeunits: timescale."

Description
Sent when a job has been configured to throw an alert if its execution exceeds a predefined time period (in minutes or hours), and the timer has expired before the job finished.

Type
Polled

VirtualMemoryUsedThresholdExceeded

Message
"Virtual Memory Used Threshold Exceeded! Value: x, Threshold: y."

Description
Sent when the virtual memory's configured threshold for memory used is exceeded.

Type
Polled

Action
Reduce memory usage by reducing the number of running processes. If necessary, request additional memory from your system administrator.

Note
View the OpenEdge VST _Startup, as it displays information about startup parameters that influence initial memory consumption. Values for AI Buffers, BI Buffers, Buffer Cache, and Lock Table size are related to shared memory.
**WS_AgentAdded**

**Message**

"WebSpeed broker added agent(s). Broker: name, Number of agents added: num."

**Description**

Sent when the WebSpeed agents have been added to the pool of available agents.

**Type**

Asynchronous

---

**WS_AgentKilled**

**Message**

One of two messages can display for this alert:

- "Agent killed. Agent PID: PID."
- "Agent cannot be killed at this time. Agent PID: PID."

**Description**

Sent when a user manually destroys an agent or agents. Typically a user initiates an agent kill action when agents hang under a connecting status for a long time.

**Action**

If the kill request cannot be processed, check the log file.

**Type**

Asynchronous

**See Also**

*OpenEdge Management: Servers, DataServers, Messengers, and Adapters*

---

**WS_AgentTrimmed**

**Message**

"WebSpeed broker trimmed agent(s). Broker: name, Number of agents trimmed: num."

**Description**

Sent when WebSpeed agents have been trimmed from the pool of available agents.
WS_AgentUnavailable

Message
"Agent has been unavailable state for more than the specified number of polls. Threshold: threshold, Number of polls: number of polls, PID: process ID."

Description
Sent when an agent has been unavailable for more than the specified number of polls.

Type
Polled

Action
Check the AdminServer log file (admserv.log) for further information about AgentUnavailableTimeout.

WS_AverageProcedureDurationHigh

Message
"The average execution time of a procedure has exceeded the threshold. Threshold: threshold Current Value: Current value Procedure: Procedure name."

Description
The average time spent executing a procedure during the polling interval exceeded the threshold. This situation could indicate a bottleneck in the application or other unforeseen events that inhibit the offending procedure from executing as quickly as expected.

Type
Polled

See Also
OpenEdge Management: Servers, DataServers, Messengers, and Adapters
WS_BrokerAbnormalShutdown

Message
"WebSpeed brokershut down abnormally. Broker: name."

Description
Sent when a WebSpeed broker shut down abnormally (crashed).

Type
Asynchronous

Action
View the appropriate log file for further information.

WS_BrokerNormalShutdown

Message
"WebSpeed broker shut down normally. Broker: name."

Description
Sent when a WebSpeed broker shuts down normally.

Type
Asynchronous

WS_BrokerStartup

Message
"WebSpeed broker started normally. Broker: name."

Description
Sent when a WebSpeed broker starts up.

Type
Asynchronous
WS_NameServerUnavailable

Message
"WebSpeed broker failed to reach the NameServer. Broker: name, NameServer: NSname."

Description
Sent when a WebSpeed broker failed to contact the NameServer.

Type
Asynchronous

Action
Check the AdminServer log file (admserv.log) for more information about NameServer unavailable.

WS_QueuedRequestPercentHigh

Message
"The percent of queued requests has exceeded the threshold. Current Value: value, Threshold: threshold, Broker: brokename."

Description
The percentage of requests queued during the polling interval exceeded the threshold. This situation could indicate bottlenecks or other unforeseen events that are slowing down request processing.

Action
Check the AdminServer log file (admserv.log) for more information about Request Queue Depth High.

Type
Polled

See Also
OpenEdge Management: Servers, DataServers, Messengers, and Adapters

WS_RejectedRequestPercentHigh

Message
"The percentage of rejected requests has exceeded the threshold. Current Value: Current value Threshold: threshold."

Description
The percentage of client requests rejected during the polling interval exceeded the threshold. This situation could indicate bottlenecks or tuning problems that prevent client requests from being serviced.

Type
Polled

See Also
OpenEdge Management: Servers, DataServers, Messengers, and Adapters

WSA_StartUp

Message
"Web Services Adapter broker started up. Broker: name."

Description
Sent when a Web Services Adapter broker starts up. This is actually a polled alert. On every poll interval (as defined in the monitoring plans), WSA status is checked. If a change in status is detected (Not Running to Running or vice versa), the WSA alert is fired.

Type
Asynchronous

WSA_ShutDown

Message
"Web Services Adapter broker shut down. Broker: name."

Description
Sent when a Web Services Adapter broker shuts down. This is actually a polled alert. On every poll interval (as defined in the monitoring plans), WSA status is checked. If a change in status is detected (Running to Not Running or vice versa), the WSA alert is fired.

Type
Asynchronous
### Index

#### A

**Actions**
- relationship to alerts 20, 36

**Alerts**
- additional information in the OpenEdge Management documentation set 24, 26
- alert-related viewlets
  - Alert severity legend viewlet 37
  - Collection members viewlet 37
  - Resources with alerts viewlet 37
- assigning alert severity 29
- clearing
  - from the command line 47
  - in bulk 42
  - individual alerts 41
- configuring 28
- data displayed 32
- data displayed in
  - Alert details Summary page 35
  - collection pages 36
  - detail frame 35
  - list frame 32
  - ToolTips 33
- default and override hierarchy (graphic) 26
- defined 19
- defining an action for 20, 31
- disabling 43–44
  - in monitoring plans 43
- noise 29
- Occurrence count field 23, 36
- OpenEdge Management internal alerts 55
- options and default values 26
- See also Monitoring plan settings options and default values on the OpenEdge Management Configuration page 26
- options and default values on the Resource Monitor Defaults pages 26
- options and default values on the Resource Monitoring Plan pages 26

**Alerts (continued)**
- properties
  - Clear alert after 29
  - Severity 29
  - Throw alert after 29
  - relationship to actions 19–20
  - relationship to rules 19–20
  - types of 21
  - viewing 32

**Asynchronous alerts**
- Always throw new alert field 23
- defined 23
- example 23
- fields in the Rule definition section 23

#### C

**Clear alert after** 29

**Clearing alerts**
- in bulk 42
- in the command line 47
- individual alerts 41

**Command-line interface**
- clearing alerts 47
- querying OpenEdge Management 45
- starting and stopping OpenEdge Management 45
- using the environment window 45

**Commands**
- alertlist
- additional options 51
- group selection options 50
- firealert 49
- fully qualified resource key 51

**Configuration Advisor**
- setting threshold values 28

**Customized Viewlet icon** 28

#### D

**Disabling alerts**
- for all OpenEdge Management resources 44
- for an individual resource monitor 43
- in monitoring plans 43

#### I

**Internal alerts**, See OpenEdge Management internal alerts
### M
- Monitoring plan settings
  - alert options and default capabilities 25–26

### N
- Noise 29

### O
- Occurrence count field 23, 36
- OpenEdge Management internal alerts
  - defining an action for all internal alerts 55

### P
- Polled alerts
  - defined 21
  - example 22
  - factors associated with 21
  - fields in the Rules definition section 22
- Polling interval
  - defined 20
  - field 22
- Proenv utility 45

### R
- Rules
  - and resource monitoring plan requirements 20
  - configuring for individual resources 28
  - relationship to alerts 20

### S
- Schedules
  - and resource monitoring plan requirements 20
  - relationship to rules 20
- Severity 29

### T
- Threshold values
  - setting
    - options to set 28
  - Throw alert after 29
  - ToolTips 33

### V
- Viewing alert details
  - in e-mails 39
  - in OpenEdge Management log file 40
  - in OpenEdge Management reports 40
  - in OpenEdge Management Trend Database 40
  - in the detail frame 35
  - in the list frame 32
  - on collection pages 36
  - on the Alert details Summary page 35
  - on the main menu bar 32
  - on the Resource Monitoring Summary page 39
  - ToolTips 33
- Viewing alerts
  - in a resource's home page 38

### W
- Web server port
  - command-line interface 45